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1 A>ora5893>

11 =

AEE, FM3 77 2 DBHIRIE%., Eclipse #X—RELI=GNUY—ILF T —UTHET I-OD0OHEFHAL
FF, "R MEEZ—F Y FON—FYzFPIZETFTRZERALET,

AETIE. ICEIZ J-Link £ L < IX ARM-USB-TINY 2R3 5-bDAEETEHLET,

KR FTLY 0OS Windows7 (32 Ew k)
ICE J-Link / ARM-USB-TINY
B—Ky hi— K SK-FM3-176PMC-ETHERNET V1.1
BBy k2L MB9OBFD18T

2 HRE

RK7TVr—2av/—MIRBESATVLINEORERRAIT, TEOEY TT,

(TYPEO)
SY—R%& SEEE Svr—SY 74 v AR

MB9A100A MB9AF102NA, MB9AF104NA, MB9AF105NA
MB9AF102RA, MB9AF104RA, MB9AF105RA

MB9B100A MB9BF102NA, MB9BF104NA, MB9BF105NA, MB9BF106NA
MB9BF102RA, MB9BF104RA, MB9BF105RA, MB9BF106RA

MB9B300B MB9BF304NB, MB9BF305NB, MB9BF306NB
MB9BF304RB, MB9BF305RB, MB9BF306RB

MB9B400A MB9BF404NA, MB9BF405NA, MB9BF406NA
MB9BF404RA, MB9BF405RA, MB9BF406RA

MB9B500B MB9BF504NB, MB9BF505NB, MB9BF506NB
MB9BF504RB, MB9BF505RB, MB9BF506RB

(TYPE1)
) —RX4E SRR NNy —DH 24 v REKRC)

MB9A110A MBOAF111LA, MB9AF112LA, MBY9AF114LA
MB9AF111MA, MB9AF112MA, MB9AF114MA, MBO9AF115MA, MB9AF116MA
MB9AF111NA, MB9AF112NA, MBO9AF114NA, MB9AF115NA, MBO9AF116NA

MB9A310A MB9AF311LA, MB9AF312LA, MBO9AF314LA
MB9AF311MA, MB9AF312MA, MBY9AF314MA, MB9AF315MA, MBOAF316MA
MB9AF311NA, MB9AF312NA, MB9AF314NA, MBO9AF315NA, MBOAF316NA
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(TYPE2)
Y—X% BERE (v r—SH T 1 v REKRL)
MB9B110T MB9BF116S, MB9BF117S, MB9BF118S
MB9BF116T, MB9BF117T, MBO9BF118T
MB9B210T MB9BF216S, MB9BF217S, MB9BF218S
MB9BF216T, MB9BF217T, MBO9BF218T
MB9B310T MB9BF316S, MB9BF317S, MB9BF318S
MB9BF316T, MB9BF317T, MBO9BF318T
MB9B410T MB9BF416S, MB9BF417S, MB9BF418S
MB9BF416T, MB9BF417T, MBO9BF418T
MB9B510T MB9BF516S, MB9BF517S, MB9BF518S
MB9BF516T, MB9BF517T, MBO9BF518T
MB9B610T MB9BF616S, MB9BF617S, MB9BF618S
MB9BF616T, MB9BF617T, MBOBF618T
MB9BD10T MB9BFD16S, MB9BFD17S, MB9BFD18S
MB9BFD16T, MB9BFD17T, MB9BFD18T
(TYPE3)
SY—R%& RERE (v r—SH 74 v o RERCO
MB9A130LA MB9AF131KA, MB9AF132KA
MB9AF131LA, MB9AF132LA
(TYPEA4)
D)—X4 BERE Ry y—CH 740 vy REKRL)
MB9B110R MB9BF112N, MB9BF114N, MB9BF115N, MB9BF116N
MB9BF112R, MB9BF114R, MB9BF115R, MB9BF116R
MB9B310R MB9BF312N, MB9BF314N, MB9BF315N, MB9BF316N
MB9BF312R, MB9BF314R, MB9BF315R, MB9BF316R
MB9B410R MB9BF412N, MB9BF414N, MB9BF415N, MB9BF416N
MB9BF412R, MB9BF414R, MB9BF415R, MB9BF416R
MB9B510R MB9BF512N, MB9BF514N, MB9BF515N, MB9BF516N
MB9BF512R, MB9BF514R, MB9BF515R, MB9BF516R
(TYPES)
TY—X% RERE (v Tr—SH T 1 v I RFKRL)
MB9A110K MB9AF111K, MB9AF112K
MB9A310K MB9AF311K, MB9AF312K

WwWWw.Ccypress.com
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(TYPES)
S)—X4 BB Ry 5—SH 740 v 9 XUTKERL)
MB9A140NA MBO9AF141LA, MB9AF142LA, MBO9AF144LA

MBY9AF141MA, MB9AF142MA, MB9AF144MA
MB9AF141NA, MB9AF142NA, MBOAF144NA

MB9A340NA MBOYAF341LA, MBOAF342LA, MBOAF344LA
MB9AF341MA, MBY9AF342MA, MBO9AF344MA
MBO9AF341NA, MBO9AF342NA, MBOAF344NA

MBOAA40NA MBOAFA41LA, MBO9AFA42LA, MBOAFA44LA
MBOAFA41MA, MBO9AFA42MA, MBO9AFA44MA
MB9AFA41NA, MB9AFA42NA, MBO9AFA44NA

MBOAB40NA MBOAFB41LA, MBOAFB42LA, MBOAFB44LA
MBO9AFB41MA, MBOAFB42MA, MBO9AFB44MA
MB9AFB41NA, MBO9AFB42NA, MBO9AFB44NA

(TYPE?)
D) —X% IR Ny T —CH T 40 v RIEER )
MB9A130N MBOAF131M, MBOAF132M
MBOAF131N, MBOAF132N
MB9AA30N MBOAFA31L, MBOAFA32L
MBOAFA31M, MBIAFA32M
MB9AFA31N, MBOAFA32N
(TYPES)
L) —X% RRERE (R Tr—SH 740 v o RIEKRL)
MB9A150R MB9AF154M, MB9AF155M, MBIAF156M
MB9AF154N, MBIAF155N, MBOAF156N
MBOAF154R, MBOAF155R, MBIAF156R
(TYPE9)
SY—X% RERE R Fr—CH T4 99 RFKRL)
MB9B120M MB9BF121K, MB9BF122K, MBIBF124K

MB9BF121L, MB9BF122L, MBO9BF124L
MB9BF121M, MB9BF122M, MB9BF124M

MB9B320M MB9BF321K, MB9BF322K, MBO9BF324K
MB9BF321L, MB9BF322L, MBO9BF324L
MB9BF321M, MB9BF322M, MB9BF324M
MB9B520M MB9BF521K, MB9BF522K, MBO9BF524K
MBO9BF521L, MB9BF522L, MB9BF524L
MB9BF521M, MB9BF522M, MB9BF524M
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1. Cypress A2 —4 —* v k SK-FM3-176PMC-ETHERNET

AETIE, ARREZBETLL-OICTROTOTSLEFEALET.

=AY &) YAGARTO
NP AT LibUSB
TNy H OpenOCD
#HSBE#IELE | Eclipse + C/IC++BFY—ILt v ~(CDT)
Fhith Java Runtime Environment(JRE)

21 JTAGAY27x—X

MCUADTOY S LDERAAHPT NV TIZIZITAGEZFEALET, JTAG ZHEHAIT IBOKRRA FEF—4 Y FDE
REUTOREICRLETS,

2JTAG 2FHT 3BDHRR &2 —4 vy FDOBER

D9AT b H—/\

GNU GDB Source Code Debugger
arm-none-eabi-gdb.exe

ARM JTAG

AR
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2.2 J-Link
J-Link IZIZ IAR HED L DEFEHALET,

3 1AR #t 3 J-Link

HMITTED URL Z SRS,
http://www.iar.com/Global/Products/Hardware-Debug-probes/DS-J-Link-ARM-09.pdf

J-Link [T TFEEDREAHY FT

W USB » 5 ERERS

W J-Link GDB H—/\h\E A4k

B RAM / Flash ~Z3A& 0] g

WISy adL—9RA Y FOERTRE
B SWD / SWV HMMEHE e

B EEEHE: 1.2V~5V
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2.3 ARM-USB-TINY
olimex #t & M ARM-USB-TINY 2R LZE9,

B 4 olimex #t & ARM-USB-TINY

HMIETED URLECSBIZELY,
https://www.olimex.com/Products/ARM/JTAG/ARM-USB-TINY/

ARM-USB-TINY [ TFEED4EENRHY 9,

B ARM YA O >®DT/\y JEHE (OpenOCD HHR— L TULWSEDIZRD)
B 53E USB2.0JTAG KV ILA BT —R

B ARMIBE#D 2x10 EY JTAG a5 2 Z{EFHAEE

B EXEHE: 2v~5V

W OpenOCD #HHR— k
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3.1 Yet another GNU ARM Tool Chain (YAGARTO)

BE. BZE<{DGNUARM AU/ SY—ILEy A, ELFERERETYz JIZARShTWET, AETIE
Michael Fischer ¥t H'Bi% L = YAGARTO &35 ARM a4 SY—ILEFERALET, AT E/1A—2 3 Uik
Windows (Intel) BIFIZa v/ ILEsh=3DTI,

ARM O 234 SLSMZH, YAGARTO 7OP x4 FE Eclipse CDTD 7OV =4 MERIZHELRY—IL (I Z 1
make 1—7 4 T ) ERELTLET,
3.2 YAGARTO Y—ILDOAHyrvno—FKAE
YAGARTO A VR—R Y RETFRENV T IR—=UHhHAH 00— RKTEET,
http://www.yagarto.de/

| 4= | L AL |O ﬂ @ Web | e vagarto,de

YAGARTO Yet another GNU ARM toolchain

FULIE

Wby ? :

How to? Why another GNU ARM toolchain?

D ownload o ; i ; i .
Initially | was searching for a toolchain with the following features:

OpendCD

Suppart e not based on Cygwin

License information o works with Eclipse

Mon-cammercial wersion « cheap for the beginners

Mote

| found some native VWindows toolchains based on MinGW, but the GOB of these
toclchains doesn't work properly under Eclipse. That's why | decide to create a new
toolchain suited for my requirements. YAGARTO was born (in 2006).

YAGARTO is divided in three packages with the following components:

o TAG debuggerinterface like the J-Link GDB Server ar the Open On-Chip
Debugger.

« Binutils, Newlib, GCC compiler, and the GDE debugger
« Eclipse Platform Runtime Binary and Eclipse CDT.

YAGARTO is a hobby project and supported only by the community. If you want a faster
start, a smoother worlkflow and professional support, take a look at a commercial
toolchain like CrossWyorlks for ARM.

EB/IDA=a2—I23%5 "Download” 4 ) vo LET,
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| D o D M @ wedb | wwnyagerto.del#dowrinad
Download

The packages of YAGARTO can be found here

Package Version Date
BEAR o
( md5: 07287 ac3cd10b1325076139065176895 ) 20100703 03072010 >

Include tools like make, sh, touch, uname and more

(RS A

( md5: SecBcd49295b0b8dd60a7 32216937 4c )

This version is an EABI version now. if you update
from an older YAGARTO version you must replace Binutils-2 21
arm-elf- by arm-none-eabi- in your makefile

Newdib-1.19.0

23122010
Note: | got a info that this version has some problems | GCC-4.52 <--___—~:>

if the "svc 0" assembler instruction is used GDB-7.2
(Emor. SVC is not permitted on this architecture)

It seems that this is a problem of the gas from
binutils 221, If you also have this problem,
use the YAGARTO version before.

Inteqrated Development Environment
Eclipse

You must download the IDE from eclipse.org, but the | Eclipse CDT
link above will give you some instructions

DO RICHEREATVERFN—Da R T v TENTVET,

CCTHEAD 2 DDV T—2DHESFHO—RFLET, 3 DED "Eclipse” & "Eclipse CDT” [& 8 ZETHli&
BLET,

&t

3.3 YAGARTOY—IDA VR h—IVAE
FEED T4 ILHE (2 2Tl "Yagarto-Downloads”) I2/8y r— S BEFEHR. ChoDA VR F—LERBLET,

[L" Ordner v

Deskiop!fagarto-Downloads

wagarto-tools-20100703-setup wagarto-bu-2.21_gee-4.5.2-c-...

“yagarto-tools-20100703-setup” (£ L  [EZ N LAEDZRFHIR) i 5 make 1 —F 4 VT 1 ZA VX F—JLLET,
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# YAGARTO Tools 20100703 Setup $ YAGARTO Tools 20100703 Setup

License Agreement
Please review the license terms before installing YAGARTO Tools

Welcome to the YAGARTO Tools

20100703 Setup Wizard 20100703,
This wizard will guide you through the installation of Press Page Down to see the rest of the agreement.
YAGARTO Tools 20100703,

GMNU GENERAL PUBLIC LICEMSE ~
It is recommended that you close all other applications Yersion 2, June 1991 B
before starting Setup. This will make it possible to update
relevant system files without having to reboot your Copyright {C) 1989, 1991 Free Software Foundation, Inc.
computer. S1 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA

Everyone is permitted to copy and distribute verbatim copies
Click Next to continue. of this license document, but changing it is not allowed.
Preamble bl

If you accept the terms of the agreement, select the First option below. You must accept the
agreement to install YAGARTO Tools 20100703, Click Mext to continue.

& I accept the terms of the License Agreement
¢~ 1do not accept the terms of the License Agreement

Cancel < Back I Next = I Cancel |

# YAGARTO Tools 20100703 Setup

# YAGARTO Tools 20100703 Setup

Choose Components Choose Install Location
Choo"se which features of YAGARTO Tools 20100703 you want to Choose the folder in which to install YAGARTO Tools 20100703,
install.
Check the components you want to install and uncheck the components you don't want to Setup will install YAGARTO Tools 20100703 in the Following folder. To install in a different
install. Click Next to continue. folder, click Browse and select another folder. Click Mext to continue.

Select components to install:
Add the make utils to the PATH variable

Destination Folder

| C:\Yagartolyagarto-tools-20100703
Description

Space required: 2.6MB € Space required: 2.6MB
Space available: 3.4GB

< Back l Mext = I Cancel | < Back Mext = | Cancel |

# YAGARTO Tools 20100703 Setup

# YAGARTO Tools 20100703 Setup

Choose Start Menu Folder & Installation Complete
Choose a Start Menu Folder For the YAGARTO Tools 20100703 Setup was completed successFully.
shortcuts, AN
Select the Start Menu Folder in which you would like to create the program's shorteuts. You Completed

can also enter a name to create a new folder.

Show details

Autostart -~
Avira
Cygwin

ElsterFormular

Micrasoft Office

Openoffice.org 3.3

Packard Bell Imagewriter

Panda Security

Sandboxie

Spiele

verwaltung e

™ Do not create shortcuts

< Back I Install Cancel I I Mext > I

# YAGARTO Tools 20100703 Setup

Completing the YAGARTO Tools
20100703 Setup Wizard

YAGARTO Tools 20100703 has been installed on your
computer.,

Click Finish to close this wizard.

Visit the YAGARTO site for the latest news,

I Finish I
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# U T, “yagarto-bu-2.21_gcc-4.5.2-c-c++_nl-1.19.0_gdb-7.2_eabi_20101223” % L < [FF N LUBOZHIRH S ARM

AVNRLS5EALA VAR M—=)LLET,

 YAGARTO 4.5.2 Setup (A= 3)

Welcome to the YAGARTO 4.5.2
Setup Wizard

This wizard will guide you through the installation of
YAGARTO 4.5.2,

It is recommended that you close all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.

Click Next to continue.

$ YAGARTO 4.5.2 Setup

Choose Components
Choose which features of YAGARTO 4.5.2 you want to install.

Check the components you want to install and uncheck the components you don't want to
install. Click Next to continue.

Select components to install:

Newlib-1.19.0
GCC-4.5.2
GDB-7.2
Add YAGARTO to the PATH variable

Space required: 137.0MB

< Back I Next > Cancel

% YAGARTO 4.5.2 Setup

Choose Start Menu Folder
Choose a Start Menu Folder For the YAGARTO 4.5.2 shorteuts,

Select the Stark Menu folder in which you would like to create the program's shorbeuts, You
can also enter a nams to create a new folder.

yagarto-GNU-toolchain|

Autostart ~
avira

Cygwin

ElsterFormular

Microsoft Offics

Openoffice.org 3.3

Packard Bell ImagsWiritsr

Panda Security

Sandboxie

Spiels

Werwaltung i

I Do not create shortcuts

<Back Tnstal Concel |

 YAGARTO 4.5.2 Setup

Y License Agreement
\ Please review the license terms before installing YAGARTO 4.5.2.

Press Page Down to see the rest of the agreement.

GNU GENERAL PUBLIC LICENSE ~
Version 3, 29 June 2007

Copyright (C) 2007 Free Software Foundation, Inc. <http:fjfsF.org/>
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

Preamble

If you accept the terms of the agreement, select the first option below. You must accept the
agreement to install YAGARTO 4.5.2. Click Next to continue.

& 1 accept the terms of the License Agreement
" Ido not accept the terms of the License Agreement

< Back. Next > I Cancel |

% YAGARTO 4.5.2 Setup

Choose Install Location
Choose the folder in which to install YAGARTO 4.5.2.

Setup will install YAGARTO 4.5.2 in the Following Folder. To install in a different folder, click.
Browse and select another folder. Click Next to continue.

Destination Folder

| C:ivagartolyagarto-GNU-taolchain

Space required: 137.0MB
Space available: 3.4GB

< Back Next > Cancel I

© YAGARTO 4.5.2 Setup

Installing
\ Please wait while YAGARTO 4.5.2 is being installed.

Extract: sample_update_policy.hpp

_Show details

# YAGARTO 4.5.2 Setup

) Installation Complete
Setup was completed successfully.
Completed

Show details

l Mext > I

# YAGARTO 4.5.2 Setup =

Completing the YAGARTO 4.5.2
Setup Wizard

YAGARTO 4.5.2 has been installed on your computer.

Click Finish to close this wizard.

Visit the YAGARTO site for the latest news.

Finish I
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4 KZ A\
4.1 LibUSB
{EE]) ZETIEE ILink ZHIZ FSA/SDBREAXREREH L TLET A, ARM-USB-TINY [THEEDABETT,

J-Link T OpenOCD T 5=OIT K SANERELET, AETIXLDUSB &EWVS R4 NEFERALET, J-
Link DIEFR®D K3 A 731% OpenOCD 125t L TWWAE Lz, LIbUSBIZANBZ Z2HELNHB-HTT, ABZIZE
Zadig EWS5 T 1) —Y—JL (LGPL 54 2> R) #FRALET, Zadig IZIEHSH L LIbUSB AEFENR TS 18,
LibUSB #AITA D> O— FFIREEHY FBA, ZadiglETROV T IR—UHOAFTEET,

http://sourceforge.net/projects/libwdi/files/zadig/

42 LibUSB DA VR F—=ILAZE

J-Link & PC &R LFET . J-Link IZEERD S A NARESNTVTH, HICHIRT 2LEEHY FHA. Zadig
EZERBR. UTOKIBV 12 FOBARTINET,

Device Options  Help

Driver [ | |winUSB (v6.1.7600.16385) | More Information
! WinUSE (libusbx)
USB ID E libusb-win32
el [7] Install WCID Driver  |¥ libusbk
= WinUSE (Microsoft)

0 devices found.

“Options” -> "List All Devices” 2 ') v LEY,

| v Create a Catalog File
v Sign Catalog & Ihetall Autogenerated Certificate

Driver .16385) |% More Information
Advanced Mode j - WinUSB (libusbx)
1USB I Log Verbosity X libusb-win32
| S—\ & J
27 Install WCID Driver  |¥ libusbk
welDs) | WinUSB (Microsoft)

0 devices found.
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TIWED A= a—Mi5 "J-Link Driver” Z:&Z3iR L. Driver & “libusb-win32 (v1.2.6.0)" [CERELE T,

Device Options Help

. D it

Driver [jlink(v2.6.5.0) I j@ﬁz {v1.2.6.0) D More Information
= WinUSE (libusb)
UsSBID 1366 ||0101

libusb-win32

5 Replace Driver ‘V libusbk
WCID = @ WinUSB (Microsoft)

3 devices found.

“Replace Driver” 29 U w9 $5¢. FIANDABZNRBINET, UTOA v E—CHHNAIEET T,

Driver Installation

-
1 ) The driver was installed successfully.

FINA AT R—T w5, “libusb-win32 devices” IZ J-Link driver "5 Z & #HEE L E T,

S 5B Y%-—T¥
TAME  BER  RTW  ALTH
- = BE @\ =Ra
= =) PC102208
(2 DVD/CD-ROM K547
# & IDE ATA/ATAPL I bO-5

[+ E8 Jungo
=) % libusb-win32 devices

[+ E8 Texas hstruments Emulators

@ & USB (Universal Serial Bus) 2 b0-3
R e i

R BV

®- @, YUK, EFA BEUSF -4 Ib0-5
o YATL FHAR

[+ e TAAD B34V

-8 FATA PEIR

[+ EB Ay hI-h PR

B {88 ba-T A2A-2112 T2

= o J0tH

w- Y b COM £ LPT)

B0 ROACEQENDRA T8 THAR
=-8 €%

[+ e FRIREAY -4
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Open On-Chip Debugger (OpenOCD)

OpenOCD &, ARMaTZIZITAGA VB 71 —REBELTT7 IV ERTB=0DA—F > Y—)LTF, OpenOCD IF
AETHEAT S J-Link, ARM-USB-TINY #EHTEL D ITAG RUTILEHR—FLTVET, <D RUTILIE,
Future Technology Devices International #t® FT2232D Fv 7% {E&H L 1= FTDI T/Af A THER I TWVET,

AETIE, OpenOCD DERAAEZHALET,

LibUSB RS54 /D&M

LibUSB K3 A /849 /R— MRR®D OpenOCD 4 YR h— LAk
LibUSB &4 #H— k L 7= Windows [@[7® OpenOCD A4 S LATRENY T TR—IShHHAH U O0—KTEET
(FM3 TlX OpenOCD 0.5.0 LI ZFERAL T &),

http://openocd.sourceforge.net/

REL. FEDO 745 (A 1E C:¥OpneOCD_LibUSB) [ZfELEY,
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5.2.2 OpenOCD OEIEREE
OpenOCD IZ[Za > T4 L—Y 3RS YT T 74 THSB “openocd.cig” BN ETY, MBOBFD1ST AN
TIVETRISRLET (R IT7ALEARETHERT S Y INTAD ) MZEFEFATLET),

binterface jlink b jLink #EMAT 2BAFCOFEEMI LTI LEEL

#interface ft2232
#ft2232 device desc "Olimex OpenOCD JTAG TINY"

ARM-USB-TINY Z{#MH

#£t2232 layout olimex-jtag —d_%)i’;'ﬁ"‘i:h%@’?ﬁg
#£t2232 vid pid 0Ox1l5ba 0x0004 AL TS0

# Cortex-M3 with 1MB Flash and 64*2 kB RAM

if { [info exists CHIPNAME] } {
set  CHIPNAME SCHIPNAME
} else {
set  CHIPNAME mb9bfxx6

if { [info exists ENDIAN] } {
set  ENDIAN SENDIAN

} else {
set  ENDIAN little

if { [info exists CPUTAPID ] } {
set CPUTAPID SCPUTAPID

} else {
set CPUTAPID 0x4ba00477

#delays on reset lines
jtag nsrst delay 100
jtag ntrst delay 100

# cortex-M3 reset configuration
# reset config trst only
reset config trst and srst

jtag newtap $ CHIPNAME cpu -irlen 4 -ircapture Oxl -irmask Oxf -expected-
id $ CPUTAPID

set TARGETNAME $ CHIPNAME.cpu
target create $ TARGETNAME cortex m3 -endian $ ENDIAN -chain-position
$ TARGETNAME

# MBO9BFD18 has 64*2kB of RAM on its main system bus
$ TARGETNAME configure -work-area-phys O0x1FFF0008 -work-area-size 0x8000
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# MBO9BFD18 has 1MB of user-available FLASH

# flash bank mb9bf500 <base> <size> 0 0 <target#> <variant> <cclk>
[calc_checksum]

set FLASHNAME $ CHIPNAME.flash
flash bank $ FLASHNAME fm3 0 0 0 O $ TARGETNAME mb9bfxx6

# 4MHz / 6 = 666kHz, so use 500
jtag _khz 500

OpenOCD DENMERERZEZ L ET, £9 J-Link EFHMAEAR— FEERLET, RIC, a2 FTRV T A SBEXD
THILIABEL. fD5]18%E DI+ T "openocd-0.5.0" ZE{TLET, fICIEa> 745 L—23>T 74D H5
THILEDIRREHRELTLEELY,

>Openocd-0.5.0 —-f <Your path to the Eclipse workspace project>/openocd.cfg

jLink ZERAL5HEE. UTORTHEENHASI S EEZHALET,

v ¥ FE 7007k - openocd-0.5.0 -f __fopenocd.cfe

1 initiated

on JT&G-pin 19:

= 1 TDI T=0TRST =0
I'¢ !

477 (m

points, 4 watchpoints
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ARM-USB-TINY ZFA L-HE. UTOETHENEASNE I LE#HERLET,

ice found: 0 17 (mfe

nts, 4 watchpoints
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(o))

6.2

Java Runtime Environment (JRE)

JRE OFEREA X

Eclipse #BI{E S BI21E. JavaRBT VEAFLTHDBELIHY ET, BIC JavaMERTE S EF v
I 5=®HICE, DOSa Y

Y)—IJLT java -version AV Y REFERLFET,

C:AWINDOWS\system 32%cmd. exe
(C>) Copyright 1985-20A1 Microsoft Corp.

C \Dukumente und

Ell‘l"‘tE].].Lll'Ig’Bl‘l\ *java —version
a_24"

Java version "1.6.8_
Java(TM> SE Runtime Environment C(huild 1.6.8_24-hA7>
Java HotSpot<TH> Client UM <huild 19.1-bB2, mixed mode. sharing2

C:~Dokumente und

Einztellungen™. o

LLaY Y FABEHETELRNESIX, IREDAS VA F—ILDBIMETY,

JREDA VR b—IVE%
JRE[XFTFED URLMNSA Y A—KTEET,

http://java.com/

jawa.comjendownloadwindows_manual.jsp

((

Java Downloads for Windows
Recommended Version 6 Update 24
Selectthe file according to your operating system from the list below to get the latest Java for your

computer.
= All Java Downloads = Remove Older Yersions =What is Java?

By downloading Java vou acknowledge that you have read and accepted the terms of the end user
license agreement

Ay windows

Windows THEPMIsta/2000/200272008 Onling werify Now
[+] = Instructions
filesize: ~ 10 MB

After installing Java,

restart your broveser and
Instrucions  yerify Java has heen

installed correctly

Windows 7APMistal2000/2003/2008 Oflineg
0 filesize: 15.2 MB

» Information about the G4-hit Java plug-in

* Typical download size is 10 MB, which is the minimum download. The size may increase if
additional features are selected

What is Java?

AR =T 7ANESDA—FL, JREDA VA F—ILERIBLTL S,

WwWWw.Ccypress.com
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Eclipse 73 v b7+ —L

Eclipse 75 v b2+ —LDAHv0— FAE

Eclipse D&E#H/N—a VETROV T IR—OMHE I O—RTEET,
http://download.eclipse.org/eclipse/downloads/

& woge Barweser x | Moo iovioes x| +
* > W A O =i eclpae. g - %

B

- - Friend &
eclipse project A Dkt =
downloads YA SRS

Suppot Exipeet Decome 2 lend

| stew Dewnlosde

©n s page you cin fnd Ba lidedl budds preduced Sy The Ecipie Pionacd To gt slacdid mom The progrinm and 56 through he wier ind Sbvisper documastalion privded » the sebes hals iyidem I you hiv
prablems downisadag the Sisps, certact the mebumaler F you Rews prstlems malafing or geting the werkbesch 2o mm. theck oot the Echpss Prasect FAQ. o Iry postng 8 sueston 59 Be tomgoas A
downriibde we provded usdir tha e and coadiions of B Eclpas Fasndalin Sclieus Uit Apcenen] uvieis slhormwan ipecied

Ses cther s2inas g proEct doveizads

B ey o wah Echpre Dansiatioes . chack ot mhe Babel project

SOX Tenonts

See o0 the Dulid schedale, resd miormanen about Afferert inds of badds access gchoved budds (nckusng lnguage packs). or tee » but of 02 spdate 1088
Build Type fis Neme Eaild Staon Build Date

Lacent Release -0 @ The, 9 Sep 2050 ~ 00 00 (0400)
352 20d 37 Siwarn Stable Bubd 82801 =0 Wed, 12 Jan S011 . 0800 {£200)
37 Srears tegration Buad K010 26000 - Mon, 24 Jan 2011 - 0800 (0500

37 Seeam Nightly Bold 2.1 =200 L Sat_ 22 Jan 2011 — 2000 (0500)
36 « Saopamn Budd eSOt 03 =m0 Wed, 19 Jan 2011 - 08 32 (2500
Language Pack
(L oowt R0t09002 |
Buiild Masve Build Stk Build Date
261 o The. 9 Sep 2030 - 36 00 (D400 i
B.i9.$-.8. & pomcre (soem) -

Helios 3.6.1 (H L < [(XZNLIE) 3R GNRy r—OWEFEELET, chonXyr—2 ¥ova—FozJ
R=VEADAZ2—HMBLAFTEFTY (AETIEL Helios3.6.1 ZEALEY),

RIEROHEEZFE o1z Eclipse 75 v F 7+ —LEFEAT 5728, A =a1—h 5 "Platform Runtime Binary” Z:&iR L
F9,

* = O N O ackgne o3

® .
ecliipse

Release Build: 3.6.1

Septemter 9, 2000 Theda downioads se provided usder the Eclipes § Aation Seewate et A

New and Noteworthy
Eclipse 3.6.1 Readme

The page pravilen aCCss 10 The vanous Sections of Ths Dudd slong with detads relsnng 10 45 rests. Test sesilts are provided
Delow a0t perfoemance esulls v podted once Thay st swndable Y00 May SCCESS The Sownlond Dage S04CHAC 10 oot platioon
by selectng ooe of the Labs i the slatlorn nigator sbove

[—- Download now: Eclipse SDK wasew
[ Poartosts bewa,
5T You sew cunently neneeng on Windews R e s 44 b
</ vy e atogrly o7 phes
pras e
Rotated Unbs _______________________ JSoeccafobs | [——
Vi Ton b teibes r W CurTert buks ©OACoER B Sesmca Daaiis Dage
Viwm Tvn ot s wanite B BN L Friend

gy

Poiema s s -

Bavate 100%s -
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Eclipse 75w b T+ —LnNAF YR T7r—2lE, HBRBOSAITOEDNAFTEET,

AETHRAT 5012147 32 Ev iR Windows [d 143 Eclipse /8w 4 — 21, "Platform Runtime Binary” [Z# %
—BLEOhpZEH VYU TBIETHEYIA—FTEET,

Platform Runtime Binary

Status Platform Download Size

& Windows (Supported Versions) 57 MB
i) Windows (x86_64) (Supported Versions) (hitp) 57 MB
i3 Linux (x86/GTK 2) (Supported Versions) (http) 57 MB
B Linux (x86_64/GTK 2) (Supported Versions) (hitp) 57 MB
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Eclipse 75 v b 74 —LDNAFJIFZLDhttp S5 —H A bMHLAFTEET, TNBAD1DDI5—HA b
ZRIRR. Foo0—FMRBEShET.

o [~ suche it Gooale =

[« ]|[o=][X][#][@ web | www.ecipse.org/downioads/donrload.phe

Download der Datei

[H' Mame: eclipse-platform-3...n32.2ip (49,6 ME)
i Dateityp:  ZIP-komprimierter Ordner
Yon: mirror.netcologne.de

Offren mit: | A ZIP-komprimierte Ordner v

[] Auswahl merken und die Abfrage nicht wieder zeigen

[ offnen | [_speichern ] [ abbrechen | [ Hife |

@, ansicht (100%) ~

[ DRIRS A R

| ri. |@ Wb | www, eclipse.org/downloadsidownload. php

[#] Speichern unter [#]

Speichern in: | 05 Downloads

il o
T [
N

verwendete O

¢ 6

Eigene Dateien

&«

Arbeitzplatz

D ateiname: |eclipse-platform-SDK-3.E.1-win32 V| L Speichern J

&&

Metzwerkumoeb | Dateityp: |Z|F'-k0mplimierterDldner[“.zip] v| [ Abbrechen J
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Ao 00— K. eclipse-platform-SDK-3.6.1-win32.zip Z1&7F L. FIZIECYIZRELET,

Datei Bearbeiten  Ansicht

Extras 7

‘.'""!7

Favoriten

v l Wechseln zu

5] \B Eigene Dateien
= Q Arbeitsplatz

[=] “e» Lokaler Datentrager (C:)
# 5 Sd1ec967a00e81e6d:
# |75 Dokumente und Einst:
= 3 edlipse

# 5 configuration

15 dropins

# [ features

® ) p2

# [ plugins

() readme

# [5) MSOCache
(= prp
# 5 Program Files
# (3 Programme
=] O Sandbox
[ WINDOWS
“e# Lokaler Datentrager (D:)
“e Lokaler Datentrager (E:)
“e# Lokaler Datentrager (F:)
é CD-Laufwerk {G:)
B’ Systemsteuerung
() Gemeinsame Dokumente

+ [ Dateien von said
< | >

I T T

i+

notice
—' 9KB

features

plugins

.eclipseproduct
ECLIPSEPRODUCT-Datei
1KB

eclipsec

Web Document

v

@ Zuriick ~ \_) 1’ /’) Suchen [1:‘ Ordner '

adresse |[7) Cieclipse

Ordner e e
@Besktop = configuration \/J dropins

)

readme

artifacts
{ML-Dokument

eclipse
Konfigurationseinstellungen
1KB

epl-v10
Op
17 KB

Meb Document

A VA =ILT7AILEEITL, Eclipse DA VA F—JLIXFETTY,
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7.2  Eclipse IDE QBAtAK %

#MHIZ, C¥eclipse 7+ ILF(ZH B eclipse.exe ZRITL. Eclipse D FOT Y FI7AIVERFET STV AR—
AEBELET,

& Workspace Launcher

Select a workspace

Eclipse PlatForm stores wour projects in a folder called a workspace,
Choose a warkspace Folder to use For this session,

Wiorkspace: | ¢:\Dakumente und Einstellungenisaidyworkspace v-" [ Browse, ., ]

[ Use this as the defaulk and do not ask again

J—JAR—XEZ/ET D L. Eclipse "REZ—kLET,

. .
—:—ecllpsﬁg

Loading !

CTTTITITITTIIIIITIIITITITITTIT]

& Resource - Eclipse Platform BEK

Fle Edt Navigate Search Project Run Window Help

Welcome to Eclipse

4 Overview Tutorials
D N

Get an overview of the features Go through tutorials

@4, Samples _/\_ What's New

Try out the samples V Find out what is new
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C/C++BAFY—IL* v I (CDT)

BEHVILIITODA VR F—ILAE
Eclipse T CIC++DRAFEE T H1=HIZI&. CDT /Ay r—T % Eclipse N VR— +F2REAHY ET, CDT /3y
T—=2ETSTADESIZAFTEET,

Eclipse TRFDY I LDz T7EA VR F—ILT B1=5HIZIL. Eclipse ZE2EILLITD EE Y "Help” -> "Install New
Software menu...” 22 ) v o LEY,

& Resource - Eclipse Platform

File Edit Mavigate Search Project Rum Window EEES]

" T e |® Welcome

(%) Help Corntertts

Q m F‘e‘* * &7 Search

Tutorials Samples What's Hew

Cryniamic Help

Kew Assist. .. Cerl+Shift+L

OverViEW Tips and Tricks. ..

Cheat Sheets...

The Eclipse Platform is a kind of

%xtensible IDE for anything a

About Eclipse Platform
@_'. C/C++ Development =

Get familiar with the C/C++ Development Tools (CDT)

dA—HFE, BMLEWY I ROz 7EBIRTEET, SHIECDT T35 4 VT THELIEAD/ Ny —T % Eclipse

AN VR M=LTBEELRKRTT, "add” K2 %5 1) v &k, "Add Repository” 7 1 > FOBRRRTEINET,

Available Software | |
—

Select a site or enter the location of a site. \:)

Wtk withe type or seleck a sike o | [ Add. .. ]

Find more software by working with the "Available Software Sikes” preferences.

#— Add Repository

BT PMlarne: | | [ Local. .. ]
1@ There

Location: | gl =1 | L archive. .. _J

@ o

[ Seleck all ] [ Deselect all ]

Details
Show only the latest wersions of available softwars |:| Hid= ikems thak are already installed
Group items by category what is already installed?

Contact all update sites during install ko find required softveare

® = Back Flext = Finish

Eclipse IZIEFHLWT ST A 2 E2A VA =T BBIZ2 D2DHENHY ET,
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TS5A4 2% IAR I7AILRZP J7A4ILDESIZA—AHILTEHESTWEBEEE. A T7S5AVTA VA R—)ILTE

ELLT

File Edt Mavigate Search Project Run Window Help

Available Software

Tutorials Samples What's New Select a site or enter the location of a site,

Overview

The Eclipse Platform is a kind of uni

Wtk with: | type o select a site

v [ adi. ]

Find mare software by working with the "Avalable Saftware Sites" preferences.

‘ bype filker bext

HMame
E (@ There is no site selected,

L4 C/C++ Development £ Add Repository

Repository archive

Mame: ‘ H Local... ]
Suchen in |@ downloads v‘ Q2 Lacaton: | ] |[ r— J
A @echpsa-platfarm-&s‘1-win32
T 3
Zuletzt Cancel
wennendete 0., ®
Desktop
[Hide items that are already installed
: y i p
Eigene Dateien What is already instaled:
H software
Iybeitsplatz
. <Back Hext = Firish Cancel
g Dateiname: | 'V| L Gfinen J - o e
Metzwerkumaeh | Dateityp: |’ia|,* zip v| [ Abbrechen }

TI3TA0EITITR=CHABAFTIEREF. AUFAUTAVRA =L (B LLRET7TYTT—F) LET,

&= |nstall

Available Software

Select a sike or enter the location of a site,

& Add Repository

Wfork, with: Name: |CDT H Local. .. JEH Add... ]

Location: |http:,f,l'dnwnlnad.eclipse.curg,ftDnls,l'cdt,freleasesfhelin | [ archive.., J & Sites” preferences.

FTUoIAVTDA VR M—IVEENMERSATOES, A4V TA VR =L BHEEEX. 41 VX F—ILATIC
Ty FI—VBRRERER LTS,

WWW.Cypress.com Document No. 002-04422 Rev.*A 25


http://www.cypress.com/

EMBEDDED IN TOMORROW™

FM3GNU V—ILF = — U & A L -REREEERE

8.2 Eclipse®y bI—22a>2450L—>3Y
“Window” -> "Preferences” M, *y k7 —9 DAV T4 L—L a3V ERETEET,

Resource - Eclipse Platform

File Edit Mavigate Search Project Run e Help

Welcome &5 e Window
e |

Mew Editor

Show Toolbar

G E BT EE R, Open Perspective 4
Show Yiew 3

Customize Perspective. .

Ove rv i ew Sawve Perspective As...

Reset Perspective...

Close Al Perspectives

Mavigation 3

@_'_ C/C++ Developme
Get familiar with the C/C++ Development Tools (CDT)

The Eclipse Platform is Close Perspecive orm - an open extensible IDE for anything and nothing in particular.

“Network connections” &R LET, DT 1 —IL KNS, Eclipse A4 V8 —Fy bAEHKRT H-OICBELHRTE

ERETEFTY,

Resource - Eclipse Platform

Search  Project Run Window Help

Tutorials Samples What's New

f £ Preferences
Overview ==
Network Connections P ¥

The Eclipse Platform is a ki

B General
(¥ Appearance Active Provider:
H ComparefPatch
@_'_ C/C++ Development | . E;_':te”t Tepes Fras Suiies

i - Editors

Get familiar with the C/C+] - keys e :::‘s i il ’:VDV-‘I- ;\‘U”" User

b K o £ lanual alse
f_u;;er Ll [] H1TPS Manual  False
; [J sowxks Manual  false
] = H Perspectives
—= Workbench basics : Search -
; : ] & Edit Proxy Entry
Learn about basic Eclipse - Security
[ Startup and Shutdown § Schema: | yTTP
- -\Web Browser
- Workspace e | |P0rt: l:l
[i}@ Team support EJ CICH+ [CIRequires Authentication:

L [ Help :

Find out how to collaboratf - User:
[#- Install/Update | ‘ Host...
& Run/Debug Password: | ‘
[ Tear it ..

move:

- el

Restore Defaults Apply

@

EEE, "Apply" RE2VZEH Uy I LTHLWLWARY =920 T745L—2a V% RELET., AT, CDT TS

TJALVEFFAVTA VR M—LTEET,
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8.3

Eclipse CDT 73551 >

CDT 7344 izl Standard & Zylin D/A—2 3 UBRFELET, EBH6N1DDN—D30FA VA —=)LLT
{£&E W (KETIE Standard ZEALEY).

FLWLWCDT 75594 0DA VAR M—ILAXEETRIZRLETD,

“Help” * =2 —Mm 5. ’Install New Software...” 5 1y v o LET,

& Resource - Eclipse Platform

File Edit Mavigate Search Project Run Window HEEIS

‘@We{mme B ‘@Wel:ome % S AECE)
(2) Help Contents
@7 Search
Dynamic Help

Key Assist... Crl+Shift+L
Tips and Tricks...

Welcome to Cheat Sheets...

Check for Updates

Install

© Overview About Eclipse Platform Tutorials
Get an overview of the features L= Go through tutorials

@4, Samples <> What's New

oy Try out the samples Find out what is new

RD7 4 > Ky "Available Software Sites” ™5, CDTDHA U UA—RFIS—H4 FEFELET, T 55— 4 I
http://download.eclipse.org/tools/cdt/releases/helios/ T,

xt 3 ske 3 Add... I
P v by e s e el
| Version I
o selacted.
Il
[(5F5557 | Avallable Software Sites © sy
+ General
* CJCe+
A [Boc oo o]
& Instalilpdate % - | Locaticn Al .
Automatic Updstes o« hrtp:fjdowrioad. eckpse. orqldakstooksupds
Avalable Software Stes o4 i odvce.crglisds g |
- Ranote Systems o4 BRtp:fdowrioad. eckpse. orqidsdp/meifupdat
) RunyDebug o4 » ecpss.orgldsd
- Toom o4 hetp: 4. eclpse.orgledipselupd
BBy o4 d.eckpse.or
o4 Ptp:fdowrioad. eclpse orqimat/1.0jupdate
D 4 AR arfent,
o4 doweload.eckpse. ol
o4 acipse. al
o4 cipse.
o4 hetp: d.eclpse.
o4 dowrload.eclpse.
m] 4 d.ecipse.
o4 Rt Jdowrioad.eclpse.orgimodelinglmamy
o4 PRt fdoweioad acioss orglmodelrnimzeiy
(m} ﬁ hitp: d.eclpse.org) ol S
9 e e ...A_,A..._M,_..'_l
E
@ Coc ] cmn | -l
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BHIDIS—YA FALELMES. "Add” K2 >% Y 1) v o LET, "Name” [Z CDT. "Location” IZ
http://download.eclipse.org/tools/cdt/releases/helios/ E AL TL F2& 0y,

! _Hesource . Eclipsn Platform

7 tnstall

' Avaiable Software: 0w L g LA P
Selact a ske or &iter the cabiAW a she. *Chpse oM 1 6 1wl b S 10

e 4w echoae o 16 1. heu-at tar a2

Workth: | typa or seect 8 ko

Welcome to Ed

% Overview
) Got an overviaw of the features

@¢) Samples
W Try out the samples

() Shom cody the latest versions of avadatie softmare [T] e Rews that are sheady irstalled
[ZlGroup rems by category What s paady nglaled?
[“] Cortact ol update skes dureg ratal to find required soltware

@ : ' '

‘OK*RAVEV 9O THE UTOV 12 FOMRKRKEINET, "CDT Main Features” & "CDT Optional Features”
DEADY R FEREET,

Wk wath: ICDI- hitp: fdownioad. edipse. orgitools fodt freleases Felos]

I".T-! Filter bek
| version |
= 90 0T Man Features:
B CICH+ Developmant Took 7.0,2.2011021 10609
4 Tooks SOH 7.0,2.201102110609
= B0 0T Optional Festures
O I+ Code aralyses Framesork (Codan) 1.0,0.201102110609
2.1,0.2011021 10609
=] 7.0.2.201 102110809
B CJC++ DSF GDB Debugger Entbegration 2.1,0.201102110609
B CIC++ GOC Cress Compier Support 1.0.0.201102110609
B % CiCH+ QOB Hardware Debugeing 7.0,0.201102110609
B % CHc++ GhU Tookhan Bulkd Support 7.0,0.201102110609
) CIC++ BN Tovkhan Debisg Suppert 7.0, 1201102110609
B 5 CIC++ Mamony View Erhancamsnts 2.1,0.201102110609
B % Cic++ Remote Launch £.0,0.201102110609
T ¥ LR Parser 5.1, 120110211009
O % €9 LR Parser S0 5.1,1.201102110609
S OOT Tasts 7.0.0.201102110609
% Eciprse Debugger For CC-+ 1.0.0.201102110609
i = 5.1,0.201102110609
% Pz CiC+# Tookhan lrstaler 1.0,0.2011021 10609
0563 Uniied Parslel © Berkeley LR Tookhain Support 1.0,3.201102110609
IO Unfied Pacalel  Support 5.1,0.201102110609
[0%* Undied Paralel C Support SDK 5.1,0.201102110609
O s CRE++ Complier Support 6.1,0.201 1021 106868
045 s CiCe+ Compler Suppart 50K £.1,0.201102110609

Gebect &l | wﬂl L1 Rorves sobecied
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RISRTEBYDRTY TERFTLTLEEL,

fwalabie Software Install Detials
P Py et g g B gt e Feview e tems o be retalled
Lol ] L '_:)‘q.
L] Werimdi M
DT - b Mol ongftooisiodreessesbelog’ .
LEA e 5 i+ Qv Devslopment Platfoom TR, orgacipse.odtpliform feshure. rop
P more: saftwans by workng with the vallable Softwape Stns” seeferences. | || 8 W I+ Devoprant Tooks TAZINE,.. ergaciopnok festreop
B Gk O+ Devsoprenit Took 5K TALAN0EL.., anjuipie.odk. sdolestunt o
b OG0B e daare Debugorg TR, ongadpse.od debugodtac fastyr,
Nave Versn _ &+ Edipse Debugoer for CiCH+ 1A0NEL... ongedipse.odt.debug.sdc festure iy
S [] ¥ (07 Msin Frsshures
] T Darvopment Tooks TOEZH IR 06
(] 4 T+ Dorvsbopmennt Tooks 50 TOE R 0600
= E--- (DF Cptioral Festarss
2{- CIC 4+ Code Arvsbysis Framework (Codan) 10D ZSL LRI 060s
(L1 ChC Dbnsper Servioes Framutwscei {D5F) Examples 10 s
=4 QI+ Darvtdopemact Platfees TOEIULE 10608 o
Dostet Al | 5toms st
Cetnks Fl 3
Soe: eoen
Detals
Ehn‘khhﬂm&mm Duu&unmm
[ Greasp o by catmgery What s il o alect
[ Contact oot st dring ot b i ey seftwane
=
@ ma ]| @ <ot oo
& Install £ |ﬁ |.F§|
Rewvipw Licenses J
Licenses must be rendesved and sccepted befors the coftwars can be installed, .ﬂ-
Licarrad; Licends baxt:
s AOE eeTTEnt Echpee Foundation Software Uiser Agreement -~
April 14, 2000
Usage Of Cortent

THE ECLIFSE FOUMDATION MAKES AVAILABLE
SOFTWARE, DOCUMENTATION, INFORMATION
ANDOR.

QTHER MATERIALS FOR OPEN SOURCE PROJECTS
(COLLECTIVELY "CONTENT),

ISE OF THE CONTENT 15 GOYERNED BY THE
TERMS AND CONDITIONS OF THIS

AGREEMENT ANDIOR THE TERMS AND
CONDITIONS OF LICENSE AGREEMENTS OR
NOTICES INDICATED OR REFEREMNCED BELOW,
BY USING THE CONTENT, wOU

AGREE THAT YOLR LISE OF THE CONTENT 15
GUWERNED B THIS AGREEMENT

ANDIOR THE TERMS AND CONDITIONS OF ANY
APPLICABLE LICENSE AGREEMENTS

Oft NOTICES INDICATED OFf REFERENCED
BELOW, TF YOUI DOy WOT AGREE TO THE
TERMS AND CONDITIONS OF THIS AGREEMENT
AND THE TERMS AND CONDITIONS

OF ANY APPLICABLE LICENSE AGREEMENTS OR
NOTICES INDICATED Of REFERENCED L

3 |{E}Iucm{tmtﬁmﬂu-al:mnm
{11 do not accept the berms of the koense agreemesnt

@ [ <tk ] 4Imd~l|mol]

WWW.Cypress.com Document No. 002-04422 Rev.*A 29


http://www.cypress.com/

A
s

CYPRESS

EMBEDDED IN TOMORROW™

-

FM3GNU V—ILF = — U & A L -REREEERE

Eclipse M CDT 7354 >D4A4 VR b—ILERBLET,

File Edit MNavigate Search Project Run ‘Window Help

& Resource - Eclipse Platform g@'@

1:@ welcome 53

Welcome to Eclipse

Overview

£ Installing Software

- 2
: Get an overview of the featu 1
)

Installing Software

| (LTI

]

Samples
g Try out the samples
[] Always run in background

Fetching org.eclipse.cdt.core.source_5....e.source_5.2.1.201102110609, jar.pack.gz

[Run in Backgroundl [ Cancel ] [ Details »>

J

~aE=2)

Workbench

TSTA40DA VR =L 015, Eclipse IDE #BiEEILET,

& Software Updates
@ y You will need to restart Eclipse Platform for the installation changes to take
L& )

effect. You may try to apply the changes without restarting, but this may
Cause errors,

L Restart Mow Mot Mow

J

J [Apply Changes Now]

: Installing Software: (29%)
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9 Eclipse IDE OfEfA %

9.1 CIC++18—ARRH T4 T
Eclipse IDE ##&E&81L £ T,

eclipse.exe

LIT®D & 5% "Workspace Launcher” &4 7B BRFShET, S ZIZIE. Eclipse CDT 7O x4 ~THEMAT S
f=®HIZHRE LTz "workspace” N ESNTWET (ML 7.2 &S5 H),

r .
=G C+HPSE

HELIOS

All rights re

Select a workspace

Eclipse Platform stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: |H:'I.My Documentsieclipse-workspace L.l Browse... I

[V Use this as the default and do not ask again

| OK I Cancel
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N T Eclipse B3I EMNY ., LUITD "Welcome to Eclipse” R—UARRINET,

- —inix]
File Edit Navigste Search Project Run Window Help
& Welcome X % T s

D

p cl;‘;s;e

Welcome to Eclipse

~4  Overview A Tutorials
%
Get an overview of the features 2 Go through tutorials
@<, Samples What's New
[ Try out the samples Find out what is new

CIC++THHET 51HAIL. CICH/IR—ARYG T 4 TABEHLET,
“Window” -> "Open Perspective” &, "CIC++" &9 1) v LT CICHN—RRY T4 T#RAEFET,

& Resource - Eclipse Platform

File Edit MNavigate Search Project Run | Window Help
New Window
Idew Editar

Show Toolbar

Open Perspective
Show Yiew »

£ Team Synchronigng

Other...

Customize Perspective...

Save Perspective As...
W e I CO m e Reset Perspective. ..

Close Perspective

Close all Perspectives

Overview Navigation ' m Tutorials
Get an overview of th  Preferences B2 Go through tutorials

®4> Samples <> What's New

ty Try out the samples Find out what is new
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9.2 c/lc++7Aavzy FOER
Eclipse C/IC++/I8\—ARG F 4 Thib, F—5 Y (ZCZTIEFM3 772 ))DFAP Y FEERTEET, "File”
->"New” -> "C Project’Z: &R L7,

& C/C++ - Eclipse Platform

File Edit Source Refactor Navigate Search Project Run Window Help

Alt+Shift+n P Makefile Project with Existing Code & <

Open File,.. 5 ;

P 2 C++ Project =
Close Chrl+ 3§ C Project \
Close 4l Grrl+shife+s: |1 Project...
Save Gl +5 Convert to a CJ/C++ Project
Save i, {27 Source Folder
Save Al Ghr|+Shift+S [ Folder
Revert |¢ Source File
v | Header File
Rer—.ame. o F2 | */ File from Template
Refresh F5 (& Class

i imil >y o

Conyert Line Delimiters To 7 Other... Ctrlen
Brint.., CEr+P
Switch Workspace 4

UTOEDEDEFH Y. “New Project wizard” T "Makefile Project” @ "+ %% ') w4 L "Empty Project” &80V %,
Foo Y A (A I1E "mbObfxxx_ioport_counter’) # AH L "Next” #9 Jw o LFET, RIZEDED & F Y Finish”

TERLES,
T il e
C Project o Select Conligurations —
Craske © projd of sslached bype Sabact platforied sl cistiadur alior voi with ) déjkny o |
Broject names: ||~b;t-|'.ux_mpm._|:mu| Project bypes:  Makesfils peoject
Tecdcdhaing:

F Use gefnit lecation Corlapagtions:
£ I \worbspagalmbibloo_opont_counter - | B Ereisk a

Project bype: Tiosodchaire:: Deselect ol
Ewecutable - Ottesr Tookchain —

=

® Enghy Frojed: Cygean GLC
@ Hello workd ANST C Project Fuitss Coetes-M3 Took
= (2 Shared Lbrary FustssCorten3 Tookhan

# [ Satic Lirary
£ Fuiby Conten M3

" i ]

Un “Advanced settings” button o adl progsct’s propertess,

Addbonal configurstions can be added after project crestion.

¥ Show project types and bookhaine onky f they ane supported on the platform Ui Manage configurations” buthons sther on toober or on property pages.
7 o || getn | [ Eeh | caca || ot | e || peen || comen |
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UTIZRT ESY., EAIZCICH+TRD Y bARTFRINFTH, FLEV—RITI7AMLEEEFNRTOERA, KB

DI5E. "File’ ->"New” ->"Source File” # B U 77 A VB EAHNRICO—T+ VT ERBLET . LHALAETIEER
BFOYV—RIT7A4IVEALAVR—FLET,

“File” ->"Import..." #9 J) v L. Z7A4LDA iR—bD 4V FOERRSEET,

(€ e poipsepationm _iox|
File Edit Source Refactor Mavigate Search Project Run Window Help
[ - = [ | @ -85~ -@- [8-%-[%-0-Q-|® -] & B cicr+

lf’:, Resource

| = 0% owi 2\ Omk| =0
An outline is not available.

Open in New Window

= Copy Ctrl+C
Paste Chrl+y,
¥ Delete Delete
Moy,
Rename... F2

43 Expart...

Build Project:
Clean Project
2| Refresh FS
Close Project
Close Unrelated Projects

Build Configurations »

“File System” ZZ#IRL. "Next' #9 Jv o LET,

(Emport =l x|
Select “
Imiport resources From the local File sysbem into an existing praject, ! - El

Select an import sounce:

I:?:! = Back Meat = Eirmeh Cancel
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“From directory” TF¥ R FARY Y AANL UiR— b LI=WTRAD Y FEAANT B8, "Browse” RE VEEIRLET,
AETHioport EVWSTFoIL—rTAD Y FEFEALFET, RTAD Y MY I b2z 7Ry T—ONE
FATLWET, HEMLHioport TAD Y FERFELTHWLTL 2L (Bl Z F C:¥downloads¥io-port),

€ tmport g = |
File system =
Source must not be empty., ( ;
1 -
From directory: | ~]| | Browse...
BT
Seloct 3 directory to import from.
(£ uninst -]
B0 s
#) var
# ) Documents and Settings _l
S ]
) inc
Inko folder: ln‘b%fxxx_-oood_:ou\tc e
) s
~ Options “ s =
I~ Querwrite existing w1 § i
" Creare complete folder structure 4 I,o_po,g
(= Create selacted folders only
advanced >> | mokeNewFoder | | [ o ]| conc |
>t Z
@ <pock | tex> [ Bt | caxel |

io-port 74 LA E:EIRK. UTDOELY "Select Al REVEI )y I LET, FAILTHOET7AIILEFERT S
=TT, "Finish" 9wy FdE. F74LDA VR— FOENRBINET,

(€ impon TP
File system Voo
Import resources from the local file system. |£ /
-
From directory: | C:\downioadslio-port >|  Browse... |
Ty |
® B le [#] .cproject
B 1) .proect
B Libio-port_ram.eff
B3 | io-port_ram.hex
io-port_ram.map
| @ makefile
e Typws...| _BessoctAl |
|
]mfo!du: | mbobfo0_oport_counter I Browse... I
[ Options - -
I o existing without 9
€ Create complete folder structure
(% Create selocted folders only
Advanced >>
@) o |
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UTD&3IZC/IC++T R 5 FIZ mbbfxxx_ioport_counter MRREINET, S ZIZEA VR—FLET 7L
FTRTCERRINET, A FED "V EV IV ITEIETAIUR— b I7AILEY)—THRLZENTEE

ERS

€ C/C++ - Eclipse Platform

Fle Edit Source Refactor Mavigate Search Project Run Window Help
| i [ g -69-d-@- |&-®-|3-0-%-|® -0 [ Ecice+
} v | er ¥ v [ Resource.
oo =5 S OB owi 2\ @mek| =0
2% Y An outline is not avaiable.
NG oot co oot o S
B inc
B-& pri
B src
io-port_ram.elf
|2 io-port_ram.hex
= io-port_ram.map
L& makefile
21 Problems 52 Tasks | EJ console | Properties | v=a
0 items
Description_~ [Resource [ path [ Location | Type |
[F 125 mbbfxocx_ioport_counter I

LUTOETIE. mainc 774 )LEV )Y LTHROIT A E2—JIZRRSETLVET . "Project Explorer” T
& main.c DEFHEBEHDBRTINET, HlIZEESH count %0 v I 5 LT,
ERESNBERAS Y TLET,

€ C/C++- mbSbfxxx_ioport_counter,

[ wis [ | & -85 [~ @~

| - - ¥ 5 S

‘main.c - Eclipse Platform
Fie Edit Source Refactor Navigate Search Project Run Window Help

J&-®-[$-0-Q-|® -]

=Bl

R cic+

[ Resource

=l
==

[8] main.c 2 =g

— - — =
7+ warranties, whether express or implied, in particular, but Al

=l =5 mb3bfxxx_ioport_counter
B-G inc
B
B sre
#1-[] core_cm3.c
—I-[€] main.c
= mbobfs06n.h
1 system_mb9bfS0x.h
o type.h
®

® count Hirection

& LEDPATTERN

© main(void)

© wait(int)

#1-[S] startup_mb9bFS0x_V11.s
#1-[8] startup_mb9bfS0x_¥21.5
€] system_mbobfsox.c
core_cm3.lst

lih core_ecm3.0

| main.lst

main.o
startup_mb9bfS0x_v21 kst
startup_mbSbfS0x_Y21.0
21 system_mbobfsox.lst

limited to, warranties of merchantsbility and fitness for a
/* particular purpose for vhich the deliverable is not designat

/* To the maximum extent permitted by applicable law, FSEU's li
/* is restricted to intentional misconduct and gross negligence
/* FSEU is not liable for consequential damages.

/% (V1.5)

R AR R AR R R TR AR RAARAAEARAARNARAAEARAARAARAREARAARAARY

#include "mbSbISO6n.h"
#include "system mbSbESOx.h"
#include "type.h"

// LED number pattern array (0 - 9)
const unsigned short LEDPATTERN([10] =
(0xCOOO, OxF900, 0xA400, OxBOOO, 0x9900, 0x9200, 0x8200, OXFS

B unsigned char // counter for LED displays
signed char count_direction = 1; // count direction

7" wait loop

void wait (int a) v
< | >

Bz outi 22\ @mak| = O

BV o %~

= mbobfsen.h

® system_mb9bf50x.h
o typeh

@ © LEDPATTERN : const unsigl

count : unsigned char
count_direction : signed ch
wait(int) : void

main(void) : int32_t

System_mbobfso:
io-port_ram.elf

[2 Problems 82\ 'rasks] =] :nnsnle] =} Pmpertieﬂ

v eq

Ditems

[5) io-port_ram.map Description = [Resource [ Path [ Location [ Type
[ makefile
[z @ jmbobhoce loport counterfsrc/main.c - [count] |

IT 42 Ea—JKHDcounth
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9.3

oo rHoY)—=25

IOz b EIVIRALTBEHIZIE. TTEHHEIL FEEMLET, IDE ® "Project” A =21 —hH 5 "Build
Automatically” DF =y I E#5H LT &L,

=1olx]
Ele Edt Source Refactor Navigate Sea'ch Project Run Window Help
e VL R i & B [$-0-Q-[®-] 50 e
— [ Resource.
JoioBuild &l 1148
w:ﬁ St » = 0Bz ow 2\ @mek| =0
Build Profect or iwplied, in particular, bus A BN o %
s Buid Working Set »liies of werchantability and fitness for a =1 mbobfSoen.h
) Includes dean... for which the deliverable is not designat B system_mbobfSoxh
B inc o typeh
+- = pri Make Target » [ent permitted by applicable law, FSEU's 1li @ © LEDPATTERN : const unsigl
55 src —— Intentional misconduct and gross negligence ®. ‘count unsigedchar
[ core_cm3.c Properties for consequential damages. @  count_direction : signed ch|
B-€) main.c &x ©  wait(int) : void
B [S] startup_mbobfS0x_V11.5 /7 (v1.5) 4 main(void) : int32_t
[-[§) startup_mbobisOx V215 JrrrrrsantrEasaRTIEASAIEE -
-] system_mbobFS0x.c
1) core_em3.lst #include "mbSbES06n.h"
core_cm3.0 #include "system rbSbfS0x.h"
main.lst #include "type.h"”
b main.o
) startup_mbbFS0x_v21 Ist // LED number pattern array (0 - 9)
[sth startup_mbobfSox_v21.0 const unsigned short LEDPATTERN[10] =
] system_mbobF50x Ist {0XCO00, OxF900, 0xA400, 0xBOOO, 0x9900, 0x9200, 0x8200, OXFE
system_mbSbfS0x.0
[2) io-port_rom.bin I unsigned char count = 0: // counter for LED displays
io-port_rom.elf signed char count_direction = 1; // count direction
5] io-port_rom.hex
| io-port_rom.map s wait loop
| & makefile void wait (int a)
< | _I_I < | |
(2 problems 53 2 Tasks | E] Console | [ Properties| T
0 errors, 1 warning, 0 others
Description_~ [Resource [ Path [ Location [ Type [
% Warnings (1 item)
[l 15 mbbfocx_ioport_counter |

oy bEY -2 LET, Project Explorer A5 mb9bfxxx_ioport_counter Z 3R L .

5 "Clean...” &2 )v 92 LEY,

File Edit Source Refactor Navigate Search | Project Run Window Help

B bobiooc iopc

) Includes
(= inc
(=4
£ src
El

a8a5%

core_cm3.c
£€) main.c
startup_mb9bfS0x_V11.s
startup_mbobfS0x_Y21.5
system_mbbiSOx.c
core_cm3 st

core_cm3.o

main. st

main.o

[ startup_mbobfS0x_v21.lst

startup_mbSbfsox_v21.0

[ system_mbobisox.Ist
system_mbobFS0x.0

[ fo-port_rem.bin

io-port_rom.elf

[ io-port_rom.hex

5] io-port_rom.map

[ & makefile

Eclipse Platform =10/ x|
O Project <)
= R-9-[H-0-Q-|®5-] o B[@ac
~ [ Resource
kB

§ S 0|[(Ezowi X\ @mk| = 0O
Buid Project [EEl BV o %7
Build Working Set »lon = -1; // count direction upua

// SU3-INT1 pressed

Properties. on = 1; // count diretion downw

// still coun

if ((1 == count_direction ) && {
¢

B < 99))

= mbobfsoen.h

1 system_mb9bfSOx.h

2 typeh

@ © LEDPATTERN : const unsigl
@® count : unsigned char

@  count_direction : signed ch|
©  wait(int) : void

4 main(void) : int32_t

count++; // count upwards, if <
»
if ((-1 == count_direction ) €& (count != 0)) // still coun
{
count—-; // count downwards, if
»
3
y
Kl | > < |
[2 Problems 3 2 Tasks | E Console | L Propertis T
0 errors, 1 warning, O others
Description_~ [Resource [ Path [ Location | Type [
E & Warnings (1 item)
4 return type of main'is not int main.c Imbbfxcc_jopor... lneS2 G+ Prob..

[ o S mbSbfxxx_ioport_counter

"Project” A —a—h
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Clean 77 4 > K2 5 "Clean all projects” A 7> 35 L. BHO IO Y F%EIRLET, "Start a build
immediately” A 7> 3 o H0 LTS,
ol

Clean will discard all build problems and bullk states. The next time a build
occurs the projects will be rebuik from scratch.

" Clean all projects 1 |(i>dempronctswbdw
[ =5 mbgbfxoo_joport_counter -

[ Start a build immediately
(% Buid the entire workepace

€ Butd only the selected projects 2

oK cancel |

OK' KRB VEH Yy TR ETaAVI«TL—a3vhRT L, 27—V 0BEBAKREY I,

& C/C++ - mb9bfxxx_ioport_counter/src/main.c - Eclipse Platform

-0l x|
Fle Edt Source Refactor Navigate Search Project Run Window Help
[ | o | @i~ 687~ @~ |& -5 ($5-0-Q-|®+-| 40 £ [E cicer
=] I o £ - [x\jRﬁuume
[ Project Explorer £2 = El) [€) main.c &2 = 0|82 outii 2 Maﬂ =0
= 11 (U ST \FRv_GFiVT TULRD & UAUGULI] (7 AWeSiniU PLESSEG
B8~ ‘ - ol BN o %~
FIE] LémI?thxxxJopavt_mmev count_direction = -1; // count direction upwa 1 mb9bfso6n.h
) Includes 3 = system_mbSbfsox.h
& inc - H typeh
& if (0 == (FM3_GPIO->PDIRS & 0x0002)) // SU3-INT1 pressed ®° LEDPATTERN : const unsig
E-E src { @® count : unsigned char
i ¢ core_em3.c count direction = 1; // count diretion downu @ count_direction : signed ch
| (4 mane € cloaning selected projects ST o war(ot s vod
i i [S] startup_mbobf50x_t11.s ® main(void) : int32_t
1 (8] startup_mbobf50x_t¥21.5 i Cleaning selected projects
- B-[g] system_mbobfsox.c \f 11 coun
& makefile I
Invoking Command: make clean b HE
11 coun
RuninBackground | Cancel | Detals>> | o, ir
o
< | > < ] o
= — . =

2 5[5 58 hE G| B 09~

(C-Build [mb9bFxxx_ioport_counter]

#*#* Clean-only build of configuration Default for project mbShfxxx_ioport_counter ***#

make clean

(2l K

| Cleaning selected projects: (0%) W
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VY—IVERKZET. V) —

VIEBEDERERDSCENTEFY,

& C/C++ - mb9bfxxx_ioport_counter/src/main.c - Eclipse Platform =10l x|
File Edit Source Refactor Navigate Search Project Run Window Help
[ wic b | & - -G~ &S |%-0- Q- |® - all B | e+
HIEC TR e 3 [ Resource
[ Project Explorer 52 = E] [€) main.c 82 = 0| 3= outi 2 @Mak1 =0
Be ;L TN SN AN SRS EATIELL it SAEnAAS whe e BN o ¥

= =5 mbbfxxx_iopart_counter
[5l) Includes
= inc
=]
B-& sre
@ core_cm3.c
@ main.c
[ @ startup_mb9bfS0x_V11.s
E] startup_mb9bfS0x_¥21.5
i €] system_mbobfsox.c
@ makefile

count_direction = -1;

if
{

(0

count_direction = 1;

}
}
if ((1 == count_direction )
{

count++;
}
if ((-1 == count_direction
{

(FM3_GPIO->PDIRS & 0x0002))

// count direction upwa

// SW3-INT1 pressed

// count diretion downu

&&

ptd < 99)) // still coun

// count upwards, if <

) && (count '= 0)) // still coun

// count downwards, if

= mbobfsoén.h

™ system_mb9bfS0x.h
S type.h

®© LEDPATTERN : const unsigi
count : unsigned char
count_direction : signed ch
wait{int) : void

main{void) : int32_t

|

| =L

(C-Build [mb9bFxxx_ioport_counter]

make clean

*###*% Clean-only build of configuration Default for project mbShfxxx_loport_counter ***%

rm -f ./sre/wain.o ./src/core_cn3.o ./sro/systen_nbSbES0x.o

./sre/startup_rbShES0x_Vzl.o

rm -f io-port_ram.elf

rm -f io-port_ram.map

rm -f io-port_ram.hex

rm -f io-port_ram.bin =
rra -f io-port_rom.elf

rr -f io-port_rom.map

rr -f io-port_rom.hex

rm_—f_in-nort_rom.hin s
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9.4 7oz FOELF

(&) KETERAT DY I b Iz FPRy5—2D makefile #ERAT 2BE. TXTHD/R Bz (E OpenOCD ~AD
IRRBE) ZRHRBL, A VXA =LA ZERB/ELTLEEL,

s

mb9bfxxx_ioport_counter 7AYo k%, BEIZA VR F—)ILL T3 YAGARTO Y —IILFz—2TaAVIRSILTE
£93, ZhiZlX. Project Explorer 5 5 mb9bfxxx_ioport_counter Z:&R L., B2 v I TRRENFEY X DS
"Build Project” #:&RL£F .

& C/C++ - mb9bfxxx_ioport_counter/src/main.c - Eclipse Platform N = DI&
File Edit Source Refactor Mavigate Search Project Run Window Help
[Nwit |G | @ -65~ (-G~ IR -®-[3%-0-Q%-|® -] & B |Fcic
J I3 o < = L Resource
[€) main.c &2 = O 82 outh 2 ® Mak] =0
11 (U T= \FRU_SUriVU-/FULRg & UAUUUL]] 7/ -We-iNiU pLEoocu 5
l ¢ B BERY o 7Y
EE=) t rount. direction = -1; // count direction upwa %1 mbobfs06n.h
! Includes New > = system_mb9bfS0x.h
& inc Go Into -8 type.h
= pr ) = FM3 GPIO->PDIRS & 0x0002)) // SW3-INT1 pressed @ © LEDPATTERN : const unsigr
= Open in New Window = i .
B-E src ® count : unsigned char
H [€) core_cm3.c Copy Chri+C rection = 1; // count diretion downu @  count_direction : signed ch
) [€) main.c paste cHly ®  wait(int) : void
| #-[S) startup_mb3bFsox : : ©  main(void) : int32_t
i 2] @ startup_mb9bfS0x ¥ Delete Delee
) [_P:J system_mbobFS0x Mcyer unt_direction ) && | A4 < 99)) // still coun
| @ makefile Rename... F2
n\_tnlmport... // count upwards, if <
223 Export...
wounc_direccion ) && (count !'= 0)) // still coun
Clean Project
5" Refresh s // count downwards, if
Close Project
5 »
Close Untelated Projects I I —l
Fonsole 22 T Properti 2 L=t
Build Configurations | pkoad [ es] v v oo
Make Targets » e Al
Index > hap
hex
Convert To... in
Run As Y 1£
Debug as » ;\ap
Profile As Y lex
Team *Lin
Compare With » Ibak ./src/core_cmd.c.bak ./sro/systen moShES0x.c.bak
Restore from Local History. .. Bt ./sre/core_cm3.lst ./sre/system mbSbES0x. lst
Properties PR 09D Lo0x V21,5 bak
_mh9bE50x_Vz1.lst Il
| z
J e < X J
1= mb9bFxxx_ioport_counter
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LUTDELSIZ, avY— IR ERAIENTEET,

& (/C++ - mb9bfxxx_ioport_counter/src/main.c - Eclipse Platform ;Igjl]
File Edit Source Refactor Mavigate Search Project Run  Window Help
| - | -6 @ G- % %50 Q- |® -] /o @
J v T e e | Resource
) Project Explorer &2 = 1) main.c 52 =im| /gf outli &3 (O] Makj =
e :* e WHO_BPAUTARLIRG & Uabondn)  r wuemdio presscuniE BN o %Y
[ =5 mb9bfxxx_ioport_counter count_direction = -1; // count direction upwa = mbobfS06n.h
[ Includes ¥ - B system_mb9bfS0x.h
B inc -5l typeh
= pri if (0 == (FM3 GPIO->PDIRS & 0x0002)) // SW3-INT1 pressed ; ® ° LEDPATTERN : const unsigl
E-§= src { - ; @  count : unsigned char
[g] core_cm3.c count_direction = 1; // count diretion downu @  count_direction : signed ch
1€) main.c ¥ B o @ wait(int) : void
- [§] startup_mbSbfS0x_Y11.5 } ®  main(void) : int32_t
[S) startup_mbobfsox_v21.s
[€] system_mbabfS0x.c if ({1 == count_direction ) && ( < 99)) // still coun
5] core_cm3.lst {
i core_cm3.o count++; // count upwards, if <
- =] main.lst }
: @ main.o
2] startup_mbSbfS0x_v21.lst if ((-1 == count direction ) && (count !'= 0)) // still coun
~[a1h startup_mbobFsx_v21.0 ¢ -
=] system_mb9bfSOx.Ist count--; // count downwards, if
system_mb9bfS0x.0 ¥ -
+|=] io-port_rom.bin < | L’—J < | _b_|
B ::22::::2:.:; {2 Problems | = Tasks Ecnnsoll}é‘,@ Epropemes] iy U,g\ o3 6B k|2 B-r5--0
=] io-port_rom.map C-Build [mb9bfxxx_ioport_counter]
[ & makefile arm-none-eabi-gcc -¢ -mopuscortex-m3 -00 —gdwarf-2 -mthunk -nmtune=cortex-m3 :l
-fomit-frame-pointer -Wall -WUstrict-prototypes -fverbose-asm -Ua,-ahlms=src/core_cm3.lsr.
'-D__BUILD_WITH EXAMPLE_ =1  -MD -MP -NF .dep/core cm3.o.d -I . -I./inc src/core cm3.c -o
'src/core_cm3.o
‘arm-none-eabi-goc -c -mopuscortex-n3 -00 -gdwarf-2 -mthumb -mtune=cortex-m3
-fonmit-frame-pointer -Wall -Wstrict-prototypes -fverbose-asm
-Wa, -ahlms=src/systen wbSbfS0x.1st -D_ BUILD_WITH EXAMPLE =1 -MD -MP -NF
.dep/system mbShfS0x.o0.d -I . -I./inc src/system mbSbfS0x.c -o src/system mbShE£50x.o
arm-none-easbi-as -g -gdwarf-2 —amhls=src/starcup_mbShfSOx_Vz1.1st —--defsym Debug_ RAM=0
‘src/scartup_mbgbfsox_vz1.5 -0 src/scartup_mbgbfsox_vzl.o —
|arn-none-esbi-gee ./sre/main.o ./sre/core_cn3.o ./sre/system mbShE50x.o0
./sre/startup rbSh£50x_V21.o -mepu=cortex-m3 -nostartfiles -static -mcpuscortex-m3
—mthumh_—mthamh—intermork —l_——start—coeonn .:l

[ |

Project Explorer IZ, 7Rz b7 Ty T 7 AL (*bin, *elf R E) NERSNTLET,

95 ALY EZ—=Hv FDERK

A AR —4y FEZBEEIZ mbobfxxx_ioport_counter 7AY x4 FZHRESATWET, HILLWIOS Y FEEY +
TyvT7Llt, 3LLEE—4 Y F2BIRLTLEEBRICAEDERAERESHBLTIESL,

mb9bfxxx_ioport_counter ® makefile BEJL F T O X ##M L £, makefile [, RAM/ROM LTF/\v 59 3%
EHDIT7AINEERLES, F1=. Cypress Flash Programmer D& 54— L ZFHA L1 Flash ~DEAHET
BI=ODTF7AILELERLET,

ALY RA2—45y FERAM & ROM (Flash) TRIRIZERT 2ENHYET ., FHLAETEIY—VREBLEMLE
TO

A B—=4y FEERT B1=5HIZ1X. Project Explorer 5 & mb9bfxxx_ioport_counter &R L., HY v I D 4
—h 5 "Make Target” &R LET,
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, f_direction = -1z
= (FN3_GPI0->PDIRS & Ox0002)) // 5w
_direction = 17 // count ¢
count_direction ) ¢« (ENEEY < 99))
» // count uw

= count_direction | €6 (Gount '= 0))

dumtﬁioiéﬁaéaﬁ

il

Hiiie

/¢ count o

src/starcup_mbSbe.
tup_mbSbes0x_V2l.o
rc/main.o ./src/core_cmd.o ./src/system _mbShLS0x.o0
£50x_Vit.o ~“mcpu=cortex-m) -nostartfiles -static -mepucortex-md
|-intervork -¥i,--atart-group
gazto-toolchain/ Lib/gee/ arm-none-eabi/ 4.5, 1/ chab/vin'
to-toolchain/ars-none-eabi/ 1t/ chusb/vim! «lc «lg ~latdces ~laupces
~T./pr)/Fu)icsu _corcex~N3_rowm ViD.ld -Vl -Napeic-port _tom.map,=
pore_rom.elf
port_tom.elf io-port_rom.hex

dbjcopy -1 elf3Z-little -O binary io-port_rom.elf 1o-port_rom.bin
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“Target name” [Z Make (RAM) & A71L. "Same as the target name” M F = v o %4 L. "Make target” [Z RAM & A

ALFET, "OK" %5 1) v 9§ 5 & T "Make (RAM)” ZERTEET, RHIZ. "Make(ROM)”, "Program-Flash”,

"Clean” #4ER L £ 9,
| & CreateMake Target

B || = Create Make Target

Target name: | Make (ROM)

EAll = Create Make Target

Target name: | Program-Flash

—Make Target

[}.5ame as the target name

—Make Target

x|

Target name: I Clean

[T~ 5ame as the target name

Make target: I RoM|

Make target: I program

' [~ Make Target

I %S:me as the target name

IMake target: Iclean|

rBuild Command

[V Use builder settings

r~Build Command

[V Use builder settings

Build command: | make

Build command: | make

r~Build Command

V' Use builder settings

i | Build command: | make

r—Build Settings
[V stop on First build error
IV Run all project builders

r~Build Settings
[V Stop on first build error
¥ Run all project builders I

~Build Sektings
V' Stop on first build error
¥ Run all project builders

oK I Cancel | oK I Ok I

Cancel | Cancel |

ROBEIZ "Make Target” Ea— DR TEET, TV UV I TBHI LT,
"Clean” DEJ)L FFnER éﬁﬁ#‘*r%i'&o

"Make (RAM)’, "Make (ROM)”,

&C ++ - mb9bfxxx

Eclipse Platform =10 x|
File Edit Source Refactor Mavigate Search Project Run MWindow Help
|- & @65~ -6~ |&-®-|$-0-q-|® |0 [ %5 pebug [G cices
2o feet o T
(7 Project Explorer 23 = B([% makefile 53 \_[S] startup_mbobfS0x_v21 ] ] system_mbobfS0x.c }”3 =l
=[] - Al
-GS FM3 1644 15 FM3
=125 mbObfxxx_ioport_counter 165# makefile rules =125 mbbfxxx_ioport_caunter
Bl Includes 1664 = dep
H= inc @ inc
B pri ¢ ROM G pr
B src
| & makefile : ASFLAGS += --defsym Debug_ RAN=0
: clean §(OBJS) §(PROJECT)_ rom.elf §(PROJECT)_rom.hex
: § (PROJECT) _rom.bin
: § (PROJECT) _rom.mwhx 1@ Program-Flash
: ASFLAGS += --defsym Debug_ RANM=1
: clean §(OBJS) §(PROJECT)_ ram.elf §(PROJECT)_ ram.hex
: §(PROJECT) _ram.bin
: § (PROJECT) _ream.mhx
B 1
@ echo "--compiling--"
$(CC) -c §(CPFLAGS) -I . §{INCDIR) $< -o $8
%0 @ %3
@ echo "--asserbling--"
§(AS) §(ASFLAGS) $< -o $8
Ssram.elf: §(0BJS)
B echo "--linking--"
$(CC) §(OBJS) §(LK) §(LDFLAGS_RAM) §(LIBS) -o $@ v
o | o
[2 Prablems (z‘; Tasks rﬁ Pn:vpevties[{'sj1 Hiskovy[EConsole 2 ?SDehug\] &4 9 ,gl CHBH .:u‘ M B-ri-50
C-Build [mbSbfxxx_ioport_counter]
T =L IU-pULC_LOMLEIL =
rm -f io-port_rom.map
rm -f io-port_rom.hex
rm -f io-port_rom.bin
rm -f io-port_rom.mhx
rm -f ./src/wain.c.bak ./src/core_cw3.c.bak ./sro/systen rbShESOx.c.bak
rm -f£ ./src/wain.lst ./src/core_cm3.lst ./src/system whShES0x.lst
rm -f ./src/startup_rmbSh£50x_V21.s.bak
rm -f ./src/startup mbShf50x_V21.lst
< | 2l - - =
i J

VY= TOLANTETEHERETEET,
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10 H>FI)Eclipse FASxH b
AETHEATSH IO Y MIUTOBRICHE>TVET,

([ makefie 22 \_[c manc |

DLIBS =

i
# End of default section
PR EREREEEEEE R EEEE R R S

@ [ core_cm3.h :

= ‘ﬁf core_cmFunc.h :_nclude EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE R
o older # Svart of user section

&b core_cminstr.h

- [R mbabfS06n.h #

& [n system_mbabfS0x.h

8- type.h llinker script # Define project name here

folder PROJECT = jo-port

i l:] Fujitsu_cortex-M3_ram_¥21.ld
|#] Fujitsu_cortex-M3_rom_v10.ld

=

# Define linker script file here
LDSCRIPT RAM = ./prj/Fujitsu cortex-M3 ram V21.ld

CEH & st source folder - - -
@18 core_cmd.c LDSCRIPT ROM = ./prj/Fujitsu cortex-NM3_rom V10.ld
B ' # List all user C define here, like -D DEBUG=1
& g} main.c -
b [ UDEFS =
*

# Define ASM defines here
UADEFS =

# List C source files here

SRC = ./src/main.c \
./src/core_cm3.c \
./src/systenm mb9hIS0x.c

# List ASM source files here
ASRC = ./src/startup mhShfSOx _V21.s

# List all user directories here
UINCDIR = ./inc

iNc ZANLFITTRTOTAD Y FTHEATBINIOAYE I 7L LAEFEATVET, ZIIZIEL, CMSIS ER 45—
F7YTOANYETFALEZEENTOET, pj ZALFIZEV VARGV TR T 7L, sic THLFITIEY—R
T7AIULDBEENRLTNET,

F=HUTLTAS Y MIlE makefile HEFERTUVET,

Includes 7 # LA IZIZEJL FIZWHER Yagarto 54 751 (BIZ 1L stdinth) AEENRTNET,
ENDY—RT7AILIEsrc T+ ILFITHEIML TSN,
FLOAYET7AILIEiInc TAHILFE LI, includes 7+ LFITHEIMTEET,
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10.1 774 IL®DIEM
JOoxy bERE. J7AILEEMLEVWIAILEEZEIRLTEYY YOI LET,

AZa—H5 "import” FEIRL TLESLY,

& C/C++ - mb9bfxxx_ioport_counter/makefile - Eclipse Platform

File Edit Source Refactor Mavigate Search Project Run  Window Help

|t | |G -6~ | R -8 |H-0-%- | =
IFy Project Explorer &3 =8 ﬁ makefile 82 [ main.c ]

‘ - 5 & Y|V bLiBs =

-l FM3 ;

B2 mb9bfxxx_ioport_counter

Bl Includes # End of default section

HERBHERRBHERERAEHERRBRERERREHERERHE

’ L@ C:fvagartofyagarto-toolchainarm:
@ C:Jvagarto/yagarto-toolchainflibj/g
- @ C:jyagartojyagarto-toolchainflibg HUHHHHHHHHHHHHHHHH
EIL/_:*: # Start of user section
Bl New »
EJ Go Into . .
@ ine project name here
@ Open in Mew Window CT = io-port
& =
% 3= SOPY Crl+C ine linker script file here
B-G pri Paste Gy IPT_RAM = ./prj/Fujitsu corte:
<) ¥ Delete Delete IPT ROM = ./prj/Fujitsu_corter
li] Move. .. t all user C define here, like
B-E src Rename... F2 =
: .c|
o the ASH defines here
B8 2 Export... s =
=-[8
@ni:_ajk 2 | Refresh FS t C source files here
- Tndox y |= -/srefmain.e
Make Targets b ./src/core_cn3.c b
/ere/system mbShiS0Ox.c
Resource Configurations 4 4 & =
Team » Bt ASH source files here
Compare With » = ./sro/startup nbSbfS0x _Val.
Restore from Local History. ..
Properties Alt+Enter t all user directories here

|’ UINCDIR = ./inc
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T7AIVERRL, "Nextt RE2 V&V ) v I LTLEEL,

o x]
Select
B\A )
Import resources from the local file system into an existing project.

Select an import source:

|type filter text

== General
i ---- @ Archive File
5 Existing Projects into Workspace
CI‘ File m

i .= Preferences
& CiC++

(= RunjDebug
& Team

@ < Back

i1

Firish Cancel

“Browse” RA V&V Uy I L, BMTBI77A1ILEERLET,

I T 2| x|
Fle system —~ 1
TR A L/J Select a directory to import from.
fromdrstrg | 3 _soye- |
o TEMP A
# ) totalcmd
B ) WINDOWS
£ 2 workspase [
® D) .metadata
= M3
e I el O .dep
Into fokder: | bt oo _inpoet_courter fr troyee.... | 8 ogmsm
O | ~ h
1™ Qverwete cxsting resousces sthout marng . Q device L d
" Croste comglete fokder structure ‘I = l _’-rl
& Creste splected foiders ooy
W»I
< New Folder Cancel
@ B s o = | o'»irJ I/
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AviR—brE, VRMIT7AILBEBMEINTNSZ EEEELTLESLY,
~Iolx]

File system

Import resources from the local file system.

=,
e |

From directory: lC:Iworkspase\,FMS‘q,cmsisi,core _:j Browse..,

~EE core 0 leficore_cm3.c
[£] core_cm3.h
O =l core_cm3.lst
O & core_cm3.0
[£] core_cmFunc.h

[€] core_cmiInstr.h

Filter Types... | Select all Deselect All
Into Folder: |mb9bfxxx_ioport_counter.finc Browse... I
Options

[ Ovenwrite existing resources without warning
" Create complete folder structure

% Create selected folders only

Advanced >> |

® < Back | [ext > || EinEh I Cancel |

“Finish’ IRZVE I Y wHFTBET, BIRLET7AIILERREIAILTICA ViR— b TEET,
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FM3GNU Y—IFr—2%#ERALI-FRREEBERZE

10.2 Includes 2 # I EASA TS5 1) %BM

WD DSATSYAYHE BIZIEstdinth) 2, Yagarto £ YR F—IL T4 ILENSA 9 IL— KT HRENRHY
Y, A FEBIRLTAEY Y v L., "Proprieties” ZZiIRLES, 22T, BRRL-7AY Y b0y
T4 9 L—2avEERTEET,

& C/C++ - mb9bfxxx_ioport_counter/src/main.c - Eclipse Platform

File Edit Source Refactor Mavigate Search Project Run Window Help

Tl | | @-&- - -|R-8-|-0-4-
[C; Project Explorer £3 =0 (o makefile (El main.c &2
N
P 568 Fis K FM3_GPIO->PFR1 = 0x0000: //
£ : FM3_GPIO->PFR3 = 0x0000; //
SR Includes Mew <. i .
(! C:fvagartofyagarts  GoInto =RPo0y;
: @ C:lyagarto/yagart:
3 i i = . 'y
Bl @ Cilvagartlvagaitl Open in New Window 0Ox0000; /,
B inc =| Copy Ctrl+C
[h] core_cm3.h Pacte G|y
- [h] core_cmFunc.h =
B[ core_cminstr.h ¥ Delete Delete OR1 = LEDPATTE
- [B) mbobFS06n.h MEYE, . OR3 = LEDPATTE
-[R] system_mbobfsox,  Remame... F2 -
‘ @ type.h g Import...
=& /4 Export FM3 GPIO->PDIR
[2] Fuitsu_cortex-m3_ == =R -
b {‘ﬂ Fujitsu_cortex-M3_ Build Project
56 55 S FM3_GPIO->PDIR
-L€] core_cm3.c &
& main_c 2 | Refresh FS rection = -1;
= ' Close Project
[#-[S] startup_mbobfS0x, o [ ieltad Proct
[€] system_mb9bFsox. R P e AR
L@ makefile Build Configurations 4 -
»
ake Targets rection = 1;
Index 4
Convert To...
Run As 4
Debug As » junt_direction
Profile s »
Team 4
Compare With 4

Restore from Local History...

ount direction

k Alt+Enter
—
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TROEBYRELTLESL,

“C/C++ General” %3%EiR

“Paths and Symbols” Z% J)LY ) v o

‘Add” &9 Uy

“Add to all languages” [TF = v ¥

“File system” &R LA U IL— K2+ LA EIETE

A9 I— K45 %ER

“browser” M "OK” #45 ) vy

“Add directory path” @ "OK” &% 1) v ¥

p s-'..p.w!w‘u u.t,'«:.t'-. Joport _countex M
Paths and Symbols e

© Nk~ wh e

!m[odn[me] =] Menage Cantigrations. .

|

(5 Inchudes | g Symbots | . Ueares | (9% Lieary Pathe | -+ Scurce tocation | (51 Output Lacatien | 1) Referonces |

3
2o D |
k_}'u 20 \ya0 ichain\ b, gcc ar abi\ 4.5.2\include-fined
GNC L}e‘,_, w0\ yagarto-toolchain\ b\ gcc) arm-none-eabi\ 4.5.2' include ___Jl‘.--
GNICee 02\ yagarto| yagarto-tookchain' army mone-eabd inchade
o - 21| —',, =
rowse For Folk
Selext & folder from File system:
Mo LS I
= () yopurto-tockhan B Mj
) amrrone-esh
L bn
) nchude
20 —l
=R T3
™ (s Is a workspace path "39‘.”
ﬂm..' -
¥ 6
: 4 S 3

¥ Show bu-n vabans
o mport Settings... | §5 Egortsetngs.., | Mkeew roider | conced_|
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HFLWSATSY T4ILEH Includes ZAHIILFIZEMENET,

++ - mb9bfxxx_ioport_counter/makefile - Eclipse Platform

File Edit Source Refactor Mavigate Search Project Run Window Help

IC5- | | @ -6 F-C-|8-8-|3-0-Q-|®F-]0 [FaR A cher
=5 Y 2 O|[[& makefile 82 N_[c] main.c ]
= FM3 DLIBS =
B = mb9bfxxx_joport_counter
SR #
- :fyagarto/yagarto-toolchain/arm-none-eabifinclude # End of default section
(1% ¢:yagartofyagarto-toolchainflibfgec/arm-none-eabif4.5. 2include BEHHEEEH BB BB H GBS H G E BB EE R RS
@ C:fyagarto/yagarto-toolchainflib/gcc/arm-none-eabif4.5. 2finclude-fixed
BHE inc T T T
E E]cme;m3h # Start of user section
-[B] core_cmFunc.h #
@ core_cmiInstr.h
@ mb9bfs06n.h # Define project name here
[ [B] system_mbobFS0x.h PROJECT = io-port
@ type.h
=& pri # Define linker script file here
Eﬂ Fuijitsu_cortex-M3_ram_v¥21.Id LDSCRIPT_RAN = ./prj/Fujitsu_corcex—M3_ram_V21.ld
E]thu;one»M3jomyl&H LDSCRIPT_RONM = .fprijujitsu_corcex—M3_rom_V1D.ld
B src # List all user C define here, like -D_DEBUG=1
© @€ core_cm3.c UDEFS =
H“@ main.c
@ startup_mb9bfS0x_v21.s # Define ASM defines here
-[€) system_mbobfsox.c UADEFS =
L@ makefile

# List C source files here

SRC = ./src/main.c b
./sre/core_cm3.c
./sre/systen nbSbE50x.c

# List ASM source files here

ASRC = ./src/startup_nbShfS50x_V2l.s

# List all user directories here
UINCDIR = ./inc
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10.3 makefile

makefile [ GNU A4 Y —)LIZHTEEL DA VARSIV avhbBREIATWET, ThoDA YA MSY
avid, A—HITE - TRELRBREBZELTIAS I FEAMITREHIZEREINET, makefile IFEARET
FRTBH Y I LDz T7NRNYr—DIZE8FRTVWET,

makefile DA VA S a3 vOEMETRICHBALET, KETEA VA NS I3 VEBEKRTEIZEHD/A—+
21T TWVWET,

BD/A— L TlE, GUNY—ILARKE L F B0 2/84 5 (arm-none-eabi-gce-.exe), 7 £ > 75 (arm-none-eabi-
as.exe), ') > A1 (arm-none-eabi-ld.exe), # TAC Y MIBELET, AVNAF, FEVITJIC&>TERSINT:
T7ANEA TSI bT7AIL (F0) EKIENET, a4 5 EFEVTZITMA, GNU Y—JL (arm-none-
eabi-objcopy.exe) MBT I Ty kT 7 AL (xelf), VoA St T+—< v b BlZ([Ehex 77 4L (*.hex) 1L L <
[FRAF Y T7AI (*bin)), EERT 2=DDEENDBETT,

TRGT = arm-none-eabi-
ccC = $(TRGT)gcc

AS = $(TRGT) as

LD = $(TRGT)1ld -v
CP = S (TRGT) obicopv

AETIH, DELINBZTRTOGNUY—ILBRSL VR F—LEanNTHBY . 3EDA VA M—IIFIEIZE-T
Yagarto A% windows D/SRIZEMEN TS Z EARIRTYT ., S 5D Y—ILIE, Yagarto GNUARM Y —JLF = —
VDA VAR=ILITFILED bin THILFIZHRIMENTNETS,

RDIS—FIE GNU Y VANERLIEZTIORTY LT 7AIL (Fell) DBIEIDIT+—T Y hEERT B=OITHE
% GNU Objcopy V—ILDF T 3 > TT,

BRUIDTIE Intel 74—y hTHBD hex Z7 AL (*hex) ZERLET ., 2TBIFNNAFT U T 7 AL (*bin) &, Kk
D17 Tl Motorola S-record M hex 7 7 A JL (*mhx) ZEBLET,

HEX = $(CP) -0 ihex
BIN = $(CP) -I elf32-1little -0 binary
SREC = $(CP) -0 srec
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ROFTTREIRTOTOD Y FEEERELET ., & LI-ARFTNE. GNU I > H & GNU Objcopy W—ILIZ & Yith
T4+#—y bAQAE—SNE=T7IOTY I 7AILIZERSNET,

# Define project name here
PROJECT = io-port

YTV Eclipse FAD Y FETROTOD Y T LFEEATUVET,

Binc: IRTDAUIIIL—FIT7AILEHKIH
Bprj: T RTDY AR YT LT 74 ILEEMH
Hsic:TRTDY—RTF7AIL (*.c &*.s) &

P Si=) (PR e

=Y DLIBS =
8125 FM3 p
:)%f.‘ hnﬂudesl # End of default section
S EEEEREEREEEEEEEEEEEEEEEEREEEEEEEEEEEEEEEEEE R
b g§°"°‘m&h include BB RRRRBRBRBRBHRHURRRRBHERHEHBRRRANNS
& h core_cnFunch | folder
&[N core_cminstr.h # Start of user section
@ [N mbobisosn.h #
@ [N system_mbobfSox.h
@ (R type.h inker script # Define project name here
T folder PROJECT = io-port
_:'_) Fuisu_cortex-M3_ram_v21.id = o
|#] Fupksu_cortex-M3_rom_v10.\d A Lefine linker scrapr Zile

CEE w0 LDSCRIPT_RAM = ./prj/Fujitsu_cortex-N3 ram V21.ld
- : LDSCRIPT_ROM = ./pr)/ruJxtsu!cortex—m!romgvm..ld

® g core_cm3.c

5[ na # List all user C define here, like -D_DEBUG=1
L) hj man.c \ UDEFS = -

# 1S startup_mbobFSOx_V21.5

& €] system_mbobfSOx.c
l é;‘“‘d 1 j.\ # Define ASM defines here

\ UADEFS =

“# List C source files here

SRC = ./src/mwain.c \
./src/core_cm3.c \
./src/system mb9bLS0x.c

# List ASN source files here
ASRC = ./src/startup_mb9bLSOx_V21.s

# List all user directories here
UINCDIR = ./inc i Header files

WWW.Cypress.com Document No. 002-04422 Rev.*A 52


http://www.cypress.com/

&= CYPRESS

- EMBEDDED IN TOMORROW™

FM3GNU Y—IFr—2%#ERALI-FRREEBERZE

RIAIWEBHEEITROEBYERTEFT,

# Define linker script file here
LDSCRIPT RAM = ./prj/MB9BFD18 ram.ld
LDSCRIPT ROM = ./prj/MB9BFD18 rom.ld

# List C source files here

SRC = ./src/main.c ¥
./src/core cm3.c ¥
./src/system mb9bfdlx.c

# List ASM source files here
ASRC = ./src/ startup mb9ofdlx.s

# List all user directories here
UINCDIR = ./inc

WwWWw.Ccypress.com
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ROIN—FEIEALFRA,. I—FDREADERCSA TS VED2—ILOBMEERMICT 25E(C. K/X—+%
FRALET,

FHAHHH A A A A
# Start of default and user defines

#

# List all default C defines here, like -D DEBUG=1
DDEFS =

# List all default ASM defines here, like -D DEBUG=1
DADEFS =

# List all default directories to look for include files here
DINCDIR =

# List the default directory to look for the libraries here
DLIBDIR =

# List all default libraries here
DLIBS =

# List all user C define here, like -D DEBUG=1
UDEFS =

# Define all user ASM defines here
UADEFS =

# List the user directory to look for the libraries here
ULIBDIR =

# List all user libraries here
ULIBS =

#
# End of default and user defines

FHEFAEE A A A A R R S
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ROIN—F+TIE, FASIH FEELRTBEIZaOVNAS, 7RIS, YA+ T a3 ELTERYT 8
NEREOAT—23Y (ANYETF7AILRSATFVED2—ILDIGF) DHRETT,

B INCDIR: A4 574N EF T a3y BlZIE. C~yHIL UINCDIR = ./inc”)
BLIBDIR:Y>HhSA TSI NEAFTay

B DEFS: aAV/IM SEEAX T ay

B ADEFS: 7tV IJSEEA TV ay

BLBS: YYAhSATS)A T ay

ANR—FIZEETHIDLERFHYFEA, TRTOEEFALGRD/A— FTRESATNSEHTY,

INCDIR = $(patsubst %,-I%,$(DINCDIR) $(UINCDIR))
LIBDIR = $(patsubst %,-L%,$(DLIBDIR) $(ULIBDIR))
DEF'S = $(DDEFS) $ (UDEFS)

ADEF'S = $(DADEFS) $ (UADEFS)

LIBS $ (DLIBS) $ (ULIBS)

RDTFFA TS FPI7AINEHESEET, DFY., sic TSN TR IRTOCI7AILETE
VIS (*S) TFANEF TS H R ITF7AIL (*0)IZLET,

OBJS = S(SRC:.c=.0) $(ASRC:.s=.0)

ROTIFIA A SORBIELALERELET

# Define optimization level here
OPT = -00

UTDA VAT avid, 2—5y O ARM 7O+t vH(cortex-m3)FEELET,

AVNASETRUTIR, PV ITFA—FEERTIBEDA VRSV avty bEERT N ERA T
VaVvERALTRELEFT,

MCU = cortex-m3
MCFLAGS = -mcpu=$ (MCU)
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GNUaQ VRS SIZE2THEASNBZITRTOA T avid, RON—FTHEELET,

CPFLAGS = $ (MCFLAGS)

CPFLAGS += $ (OPT)

CPFLAGS += -gdwarf-2

CPFLAGS += -mthumb

CPFLAGS += -mapcs-frame

CPFLAGS += -msoft-float

CPFLAGS += -mno-sched-prolog
CPFLAGS += -fno-hosted

CPFLAGS += -mtune=cortex-m3
CPFLAGS += -mfix-cortex-m3-1drd
CPFLAGS += —-ffunction-sections
CPFLAGS += -fdata-sections
CPFLAGS += —-fomit-frame-pointer
CPFLAGS += -Wall

CPFLAGS += -Wstrict-prototypes
CPFLAGS += -fverbose-asm
CPFLAGS += -Wa, —ahlms=$ (<:.c=.1lst)
CPFLAGS += S$ (DEFS)

CY—RITFAINEAVINL—FENBIAYET T 74 I EDRIDIKRFBEREZERT HEHIZ, VR4S 755 %(&
ARREICHRTELET, £ ENB1EHRIE "make clean” TTAY Y bEVU—2F 5 LHIBENET,

# Generate dependency information
CPFLAGS += -MD -MP -MF .dep/$ (@F).d

LUTOFIEGNU TV TS I7545TY,

ASFLAGS = $ (MCFLAGS)

ASFLAGS += —-g

ASFLAGS += -gdwarf-2

ASFLAGS += -mthumb

ASFLAGS += -—amhls=$(<:.s=.1st)
ASFLAGS += $ (ADEFS)

RON—KFY NI TERELET,

LK = =-static -mcpu=cortex-m3 -mthumb -mthumb-interwork
LK += -nostartfiles

LK += -W1l,--start-group

LK += -1lc -1lg -1lstdc++ -lsupc++

LK += -lgcc -1lm

LK += -Wl, -—end-group

WWW.CYpress.com Document No. 002-04422 Rev.*A 56


http://www.cypress.com/

o CYPRESS

-— EMBEDDED IN TOMORROW™

FM3GNU Y—IFr—2%#ERALI-FRREEBERZE

A makefile L RAM/ROM DTNy TRDT O Ty b T 74IL (Celf) ZERTHELRFTOEREZEEBLET, &
EHL, TRhENADTNAY T a0 T4 00Lb—2a3 D) VARG ) TR I 7AILIERARIZHRE LEITAIER 540
HTI,
RODAVARSHLIVIERAMDYY v Hh 55T,
1. prf ZAILFIZHIMSN TS RAM RS ) 7 k7 7 4 JL "Fujitsu_cortex-M3_ram_V21.ld” Z5&E L.
LDSRIPT_RAM @5 % 5% %
Iy T T 74 (*.map) FERK
SATSVIANEEEZD BRESNTLSIER)

LDFLAGS RAM = -TS (LDSCRIPT_RAM)
LDFLAGS RAM += —Wl,—Map:$(PROJECT)_ram.map,——cref,——no—warn—mismatch
LDFLAGS RAM += $ (LIBDIR)

RODAVARSHSIVIEFROMDY Y HIS55TY,

BMpj 24 LFIZEMESNATLS ROM R4 1) 7+ 7 74 )L ’Fujitsu_cortex-M3_rom_V10.1d” Z 5 E L .
LDSRIPT_ROM % 5% %

BTy TIT74)L (*map) LR

BSAT3Y T NEEEZD (BESNATLSIES)

LDFLAGS ROM = -TS (LDSCRIPT_ROM)
LDFLAGS ROM += —Wl,—Map:$(PROJECT)_rom.map,——cref,——no—warn—mismatch
LDFLAGS ROM += $ (LIBDIR)

RDIN—FTIE RAM =5y b EERTE-ODAA I IL—ILEEELET, RAMZ—5 Y FZEILFTHIE
T, IRTODF TP LT 7AI (*0) ET7I LTy FT7 AL (*els, *.bin, *.hex, *mhx) NERSINET,

1. BRUDEEISHIET7EYTSHITTER Debug RAM [Z 1 £3]FE ., AE (T startup_mbobfdlx.s 7 7 A LD
if XTEITSHh, RAM & ROM O #PHLIL—F U ZXAT 5

ATz LT74IL ($(0BIS)) MEI FERRIIZA—4S v bEO)—2F 3
TorTy RT7AI (Relf) DEIL FERA

TIbTY ET7AIL (.hex) DEIL R &GRSR

T bTy kT 7 AL (*bin) DEJL K EEHA

T bTY ET7AIL (*.mhx) DEJL K EBA

o gk w D

RAM: ASFLAGS += --defsym Debug RAM=1

RAM: clean $(OBJS) $(PROJECT) ram.elf $(PROJECT) ram.hex
RAM: $(PROJECT) ram.bin

RAM: S (PROJECT) ram.mhx
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ROITTIEROM 2—47y FERERZRBLTVET . ROMEZ—S Y FEAM IV EZ—F Y FOTIA I MIBRESH
TWEY, 'makeal’ A¥Y FTROM2—4y FOEIL FTOERMBHIBENET,

all: ROM

Z# Debug RAMZOIZERELET ., FNDA VA LSV LI VIERAMA—4Fy FERBT. 7O TV T 74
ILDFH ROM N—2 (*_rom.elf, *_rom.hex 2 &) [T Y FF,

ROM: ASFLAGS += --defsym Debug RAM=0

ROM: clean $(OBJS) $(PROJECT) rom.elf $(PROJECT) rom.hex
ROM: $ (PROJECT) rom.bin

ROM: S (PROJECT) rom.mhx

EINRTOERERIBETEIET, TRTOY—RT7AIL (*¢,*s) WA TPz I b IT7AI (*o) ZERLET,

(*.0) Z7A4NEQ A ILT B, GNU O /84 5 (CC=arm-none-eabi-gcc.exe) MaA—ILENFET, 7545
(CPFLAGS) EANY A I 7 A ILDEIREN I VA FIThizdnET,

%0 : %C
@ echo "--compiling--"
$(CC) -c $(CPFLAGS) -I . S$(INCDIR) $< -o s@

ROFTIE7 LTS TAERTE, GNU 7E > TS5 (AS=arm-none-eabi-as.exe) [EA TSz b7 7M1 ILEERL
FJ . ASFLAGS 1%, BRICE&ZLEZROME LKIFRAMDELL ROV T4 5 L—23 2 T35 T,

%0 : %S
@ echo "--assembling--"
$(AS) S$(ASFLAGS) $< -o s@

IyoH 7Ot ATlE, GNU 3 /84 5 (CC=arm-none-eabi-gcc.exe) MA/IRA S ETE VTSI >TERSNE
FTRTDATZI T 74 ($(OBIS)=*0) MEFT I LTy FT7A)L (*elf) EERLET,

ROM #—4w hEEIL FFT B, GNUY VAHIEROM Y VARV Y TR I 7 A IVERET BHITF T3
$(LDFLAGS_ROM) (LDFLAGS_ROM = -T$(LDSCRIPT_ROM)) Z#ERAL £ ¥,

$rom.elf: $(OBJS)
@ echo "--linking—--"
$(CC) $(OBJS) $ (LK) $(LDFLAGS_ROM) S (LIBS) -o $@
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RAM 2 —4y R EIL KT 3K, GNU Y VAHIFRAM YA RS T +T74)L "LDSCRIPT_RAM = /prj/
MB9BFD18_ram.ld” 4 E 3 51=8I124 7 3 U $(LDFLAGS_RAM) (LDFLAGS_RAM = -T$(LDSCRIPT_RAM)) %
FERALET,

$ram.elf: $(OBJS)
@ echo "--linking—--"
S (CC) $(OBJS) $ (LK) $(LDFLAGS_RAM) S(LIBS) -o $Q@

RDIS—FIEL TORTY RT7AIL (Celf) ZIFDD T +—T v b (*.hex, *.bin, *mhx) [(CEHRLET,

GNU 1—5F « ) 7«4 (CP=arm-none-eabi-objcopy.exe) [EEI KTAERTEFNEFND T+ —< v b ZERT S 1=
HIZERALET,

GNU Objcopy Y —ILIZ. & makefile ®#E&HIZ HEX, BIN, SREC®- Omba—)LEnEF, Objcopy T a vk
oI ERELET,

Shex: %elf

$ (HEX) $< s@
%bin: %elf

$ (BIN) $< s@
$mhx: %$elf

$ (SREC) $< s@

H)—2B—5Fwy rEclean L—ILTEEEINET, makeclean A Y FIFFTRTOA TSI T 74 (*0), U
ZRTFAI (FIst), T R Ty kT 7 4L (*elf, *hex, *bin, *mhx) I LET, clean L—ILIE. RAM % L < 1%
ROM D E L FEIcL > da—ILEhFET,

clean:
-rm —-f $(OBJS)
-rm -f $(PROJECT) ram.elf
-rm -f $(PROJECT) ram.map
-rm -f $(PROJECT) ram.hex
-rm -f $(PROJECT) ram.bin
-rm -f $(PROJECT) ram.mhx
-rm -f $(PROJECT) rom.elf
-rm -f $(PROJECT) rom.map
-rm -f $(PROJECT) rom.hex
-rm -f $(PROJECT) rom.bin
-rm -f $(PROJECT) rom.mhx
-rm -f $(SRC:.c=.c.bak)
-rm -f $(SRC:.c=.1lst)
-rm -f $(ASRC:.s=.s.bak)
-rm -f $(ASRC:.s=.1lst)

WwWWw.Ccypress.com

Document No. 002-04422 Rev.*A 59


http://www.cypress.com/

o CYPRESS

>~ EMBEDDED IN TOMORROW™ FM3 GNU W—LF = — > % {5 L -BISIBEHE A%

RD/X— k& OpenOCD %#EA L THE Flash ICEFRALKRICHERA LET . &/3— k&, J-Link GDB Server # &
LTT7I Ty bT7A0 (Fell) DEBAAOTNY T T 2BEELEHYFEA.

#WHDO T OlF OpenOCD DIFFFZEHRELET . XD~ % OlF OpenOCD H—/\ (openocd-0.5.0.exe) #/ELET,
OpenOCD H—/NIFRV YT+ T4 L—2avhRBETY, AV FITHLE (NNRADRY Y T+
(openocd.cfg) BMEAINFET,

# specify the directory where openocd executable and configuration files
reside
OPENOCD DIR = <HERE YOUR PATH TO OPENOCD>/openocd-0.5.0/src

# specify OpenOCD executable
OPENOCD = $ (OPENOCD DIR)openocd-0.5.0.exe

# specify OpenOCD configuration file (pick the one for your device)
OPENOCD CFG = -f ./openocd.cfg

RDIS—FEFM3IANTOT S LEEEAL 2D OpenOCD OT > K TT,

# specify OpenOCD flash programing commandos for FM3
OPENOCD C += -c init

OPENOCD C += -c jtag khz 500

OPENOCD C += -c reset init

OPENOCD C += -c verify ircapture disable

OPENOCD C += -c halt

OPENOCD C += -c poll

OPENOCD C += -c 'FM3 mass_erase 0'

OPENOCD_C += -c 'flash write image $ (PROJECT) rom.bin 0x0 bin'

OPENOCD C += -c reset run
OPENOCD_C += -c shutdown

BED/I—E, B—5 Y b~®D program (Z5AH) DETTY,

DI —NEFBVETOoNFza T4 L—2 a3 VR 9 ) T+ (openocd.cig) #RA2—hEE8FET, RV T FE
T, Y—N\EEAONEAT U FEETLET, BAANETTHE. H—NEP vy FF DL Eclipse D3>
Y —JLIZ “Flash Programming Finished.” £ WLV5 A w+—CF#RTLET,

# program the FM3 internal flash memory
program:
@echo "Flash Programming with OpenOCD..."

$ (OPENOCD) $ (OPENOCD CFG) $ (OPENOCD C)
@echo "Flash Programming Finished."
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11 Flash A ) ~DEAH

11.1 OpenOCD & Flash EA#

OpenOCD Z{#EMA L THE Flash A E) 20T S LEEEALT2HIZ, Program-Flash /e LE L O5FE%
),

10.3 ETI& makefile THEASNDZTARATOEY a3 OFRBAEEH L TLVET, &K makefike TETSINIHEDLE
< avid. AE Flash IZEERALT-HIZ Eclipse @ “C/C++/I8— AR T 4 J" THEASND AL 58—y D
"Program-Flash” #&EB L %9,

JTAG A4 3 7 T —A M5 USB TEHliAR— K "SK-FM3-176PMC-ETHERNET V1.1" & PC ##&# L T 2 &L,

W& Flash AT R J 5 LZEZADTH. HHIZ Make(ROM) DEIL RBBRETT, /N1 F 1) T 74 L "io-
port_rom.bin” BNEREINFET (9.5 EEXSH),

Make(ROM) 7 ) w9 LTL &L,

BEFUORSA. @ Make R 32| = O
@ G b

= 1% imb3bfex_ioport_counter

[= dep

== inc

= prj

= src
(@) Glean
Make(RAM
Mak e (ROM)
(@) Program-Flash
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fle Edt Source Refactor Mavigate Search Run Broject Window Help

I3~ |6 g -&-¢- - |8 - 8- |5-0-@-|®5-]|0 [ I e i i o
1 project Explorer 23 S5 T 20| mane [ 6 makefile 5 = 0 (3= outne [ @ make Ta 52 =0
s io-port_sk-fm3-100pme 243 OFENOCD © 4= ¢ halt ’ &l @98 | & =3
B 4 Binaries 244 OPENOCD_C 4= —c poll [=RE)
(=) Includes 245 OPENOCD_C += —c 'fm3 chip erase O
B inc 246 OPENOCD_C += —¢ reset halt
B prj 247 OPENOCD_C += —c 'flash write_image §(PROJECT) rom.bin Ox0 bin'
B sre 2498 OPENOCD_C += - reset rum
B35 io-port_ram.of - [amjle] 249 OPENOCD_C += —c shutdown
“- b fo-port_rom bin 50
u_'_1 io-port_rom hex 251 (&) Make (RAM)
B :ZEZ:{ZE ::: 252 # program the FM3 internal flash memory with OpencCh ) Make (ROM)
_rom. 253 program: ) Progran-Flash 1-Flash
] Flasharm.log 254 fecho "Flash Programming with OpenQCD ..." ) Program-Flash-OpenacD

255 § (OPENOCD)  § (OPENOCD_CFG) § (OPENOCD_C) TS io-port _sk-fma-4gpme-ushstick
% openocd.cfg 256 @echo "Flash Programming Finished. " 1125 io-port_sk-Frn3-6dpmc 1
2% in-port_sk-Fm3-4@pmc-ushstick 257 -

15 io-part _sk-fm3-64pmel z55#

259# Include the dependency files, should be the last of the makefile
260 #

261 §{shell mkdir .dep 2»/dev/null) §(wildeard .dep/?)

262

263 J-LINK

264 jElash = C:/Prograws/SEGGER/JLinkARM V44zc/JFlashiRN.exe

265 3flash p = C:/Programs/SEGGER/JLinkiRN V4dzc/Samples/JFlash/ProjectFiles/MESxFxxx . 1 lash
266

267 3flash o += —openpri§(jflash p)

262 jElash_c += —open$ (PROJECT)_rom.bin,0x0

269 1flash ¢ += -auto

270 flash_c += -exit

271

27 # progrem the FM3 internal flash memory with J-Flash

273 progjlink:

274 @echo "Flash Programming with j-linmk..."
275 ${jflash) §(jflash_c}

276 flecho "Flash Programming Finished.”

277

27R# wEE FOR trw

4
EJ Console 5 .. Problems| T EEEELEEE

C-Build [io-port_sk-fma-100pme]

) & io-pork_sk-fm3-100pme/makefile: |

EJL Ff#. Program-Flash Z EJL KTE 5 & S5ICYET, Y1) vo 95 & T, OpenOCD H 5 Flash ~DEAH
MR IhET,

=]

=S (@) Make . 2 T O
@& @ 4 o

= =% imbSbto_ioport_counter
= dep
= inc
= prj
= =rc
(@) Clean
(@ MakelRAM)
(@) MakelROM:

Program-Flazh
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FM3GNU Y—IFr—2%#ERALI-FRREEBERZE

LUTDOE(E. OpneOCD %{$ M L 1= Flash £5A& T Eclipse DA VY —JLIZRREND A v tE—CERLTUWET,

= console £3 [&Problems} s | LA BH ._||| M E-Ci-70
_-Build [in-port]

target halted due to debug-request, current mode: Thread -:J
xP3R: 0x21000000 pc: Ox00000154 msp: Ox20007££0

Info : Fujitsu MESExxx: Chip Erase ... (way take several seconds)

fin3d chip era=se complete

Info : Fujitsu MESES00: FLASH Write

wrote 1768 bytes from file io-port_rom.bin in 0.215754s (7.893 KiB/=)

Info : JTLG tap: mbSbhfxxé.cpu tap/device found: 0x4bal0477 (mfg: O0xEZ3b, part: Oxball, wver: Oxd)

WMarn : Only resetting the Cortex-HM3 core, use a reset-init event handler to reset any peripherals
shutdown comnand invoked
"Flash Prograganing Finished., ™ |
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A
L

12 Eclipse 4 8Y—ILDEy rT7 v

121 SNEYy—IiL
[fE&E) RETEH TS a>7145L—2aVviE SETHEALERAREZHEALTVWET,
V72490 —232%ey b7y TTIEE. BADAS VR =LA EFRALTLESLY,

‘Run” D FILEH A= 1—h 5 “External Tools Configurations...” 9 ) w935 &ETY—ILESL VA R—ILT
TFET,

G (& Josce Refaqr Yevigate Segch Bun Dot Window b

r%e T e TRl - - ls-0 -~ . - . -0
) Project Exploree 53 S D 5 mobatie 3N |
B 4 OPT = =00 B »
—— | T |
= 35wt _kpert_counter ' — = —~ i
+ 4 enaries ¥ Znd of user defines
. Inchudes LELEL AR R R LR LR L LR P LR PR LR DL LR LR PRl L P LR P
DR
: :: INCDIR
L 04
4§ oport_srom.of - [amfle] LINDIR
oport_gom.bn
oport_sombax o (¢ - L
Eaat poi DEFS ~DRUN_FROM_FLASHeO -DVECT_TAB_SRAR
orport_1om srec A et S M rermere .
\ mafefie bErS $(UDEFS) §(UDEFS) -DRUN_FRON_FLASN=1

12.2 Y —IL& LT OpenOCD %R
JTAG 4 A2 7 = —RIZ J-Link AT 5154, OpenOCD #4 &Y —IL & LTEREL J-Link CERATES & 512E
ELET,
oML, a2 T 45 L—232T 74O openocd.cfg & OpenOCD_LIBUSB 7 # JL &
(C:¥OpenOCD_LibUSB) IZaE—LTHEWLTL &L,

Eile Edit View  Favorites Tools Help

@Back -~ '\) - 7” ’ /v:A\/Search |{~ . Folders ‘ "‘;s L:'f} x g | v

Address [ C:\0OpenOCD_LibUSE

MName = l Size ] Type l Date Modified l
ICbin File Folder 4/12j2011 1:49 PM
ICboard File Folder 4f12j2011 1:42 PM
L drivers File Folder 4/12j2011 1:42 PM
I[Dinterface File Folder 4/12/2011 1:49 PM
L) source File Folder 4/12j2011 1:49 PM
IL_Jtarget File Folder 4/12j2011 1:49 PM
E:l changelog-0.1.0-0.2.0.kxt 4 KB Text Document 71142009 10:11 AM
=| changelog-0.2.0-0.3.0.kxt 4 KB Text Document 11/5/2009 4:40 AM
£] changelog-0.3.0-0.4.0.txt 4 KB Text Document 2j21j2010 9:17 PM
I'%j info.kxt 1 KB Text Document 2J23j2010 5:56 PM
g 25KB Text Document 1/16/2010 2:07 PM
27 KB Text Document 7i7/2009 5:53 PM
18 KB Text Document 7i2j2009 12:30 PM
118 KB File 4/26j2011 10:11 AM
zOpenOCD User's Guide.pdf 856 KB Adobe Acrobat Doc... 2f22j2010 7:02 PM
openocd.cfg 2KB CFG File 4/20j2011 5:09 PM
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“Run” -> "External Tools” -> "External Tools Configurations...” @QIEIZZ 1) v 9 LTL &L,

& C/C++ - FM3/makefile - Edlipse Platform

Be EdR Souce Refactor Navigate Search||Run Project Window b

ok udm~&1'Q“ amfl L e | e it
e = ©. Debug Fii
M—‘ PR Run History »
=R Run Ag »
® 5 s | Run Configurations. ..
45 mbbéxoox_joport_counter
B &2 onaries Debug Hetory »
B35 Inchud Debug As Y FHRAHRBRAHARRRAAORBHARHRBRRABBRBHRBRRARBHAAA
& ‘_~ nc Debug Configurations. ..
& & pr R N Orleshieis
& e IO Bt COESELEE D INCDIR) § (VINCDIR))
o To, Edgoi. DLIBDIR ULIBDIR
# L5 io-port_rom.ef - (armfle] 'r‘:”‘“”,wjr‘-( T VIR) §¢ 1)
wo-port_rom.bin TOgYe Mathod Bresiog
ufosmhox il DRUN_FROM FLASH=D -DVECT TAB_SRAN
0-port_rom.map W, Skip All Braskpoinks - - R L
O-poet_rom.srec Rm W
~ = & o DRUN_FROM_FLASH=1
i alte __ Breskpoint Types » =
I OBJS = $(ASRC:.5~.0) S(s;
LIBS = $(DLIBS) $(ULIBS) LSO RO0Ls LU 3N 3
MCFLAGS = —mcpu=$ (MCU) ol s 460
ASFLAGS = §(MCFLAGS) -g —-gdwarf-2 -Va,-amhls=§(<:.s=, 1sc) §(ADEFS)
CPFLAGS = §(MCFLAGS) §(OPT) -gdvarf-2 -mthumb -fomit-framws-pointer -Wall
LDFLAGS = $§(MCFLAGS) -mthumd -nostartfiles -T$(LDSCRIPT) -¥1,-Map=$(FULL

“External Tools Configurations” 7 1 > FOMNKRRENET, "Program” 5 1) v - L. "New” RE U H S L LHED

Y—ILEERLET,

& External Tools Configurations z‘
Create, manage, and run configurations

Please specify the location of the external tool you would like to configure,

(% J
- |

Configure launch settings from this dialog:

| 7 = Press the New' button to create a configuration of the selected type.
|, = Press the Duplicate’ button to copy the selected configuration,
3 - Press the Delete’ button to remove the selected configuration.
_i% = Press the Fiker' button to configure filkering options.
- EdRt or view an existing configuration by selecting .

Configure launch perspective settings from the Perspactives preference page.
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“Prigram” # 4 TILY 1) v LTLEELY,

& External Tools Configurations 3 _X_]

Create, manage, and run configurations 0
Please specify the location of the external tool you would like to configure. ﬁ?
il
B J
R EER, | =] ::19 = MName: |New_conﬁguration
|type Fiter text El Main o5 Refresh) [ond Buildw " Environmenq = gommon] b
&= @, Program ~Location:

Mew_configuration

Browse Workspace. .. | Browse File System... l Variables... |

—Working Directory:

Browse Workspace... | Browse File System. .. l Variables... |

— Arguments:

= |

TA—LIZTRONBEEREICEALTVEET,

“Name” [Z1% OpenOCD & AL TL ZELY,

"Location” 12, £IT7 74 ILT#& 5 openocd-0.5.0.exe # FEEDEHYIEELET,
C:¥OpenOCD_LibUSB¥bin¥openocd-0.5.0.exe

“Working Directory” I&. "Browse File System...” R2 > %9 1) w4 L C:¥OpenOCD_LibUSB ##EELF T,
Arguments (&, 51% *-f<your project path>¥openocd.cfg” Zi§E L E 7.
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& External Tools Configurations

x|

Create, manage, and run configurations Q
Run a program

=

< 3= - -,
FEX |52

Name: | OpenOCD(LIbUSE)

| type Fiter text (5] Main Refresh] (510 Buﬂcﬂ % Environment] =) g_ommon]
= % Program - Location:
Q ©Open0OCD I C:10penOCD_LibUSB\bin\openocd.exe

Ope

Browse Workspace... | Browse File System... | Variables. .. I

—Working Directory:
| C:\OpenOCD_LibUSB

Browse YWorkspace... I Browse File System. .. I Variables... I

Arguments:

-f .jopenocd.cfg

=

=

Mote: Enclose an argument containing spaces using double-quotes ().

Apply. Heverk
Filter matched 3 of 3 items I I

@

Run Closeh I
N

“Build”4 @ ’Build before launch” ®F T v #5 L TL &Ly,

Name: | OpenOCD(LbUSE)
r Main (q;‘h Refresh | o1 _B[._lild\ﬁ Environmenq = (_Zommon]

MDA T (Refresh, Environment, Common) (FZEETIHEEHY FEA.
“Apply” & "Close” % 1) w4 L., OpenOCD D4 &Y —ILEREZFELET,

BNk Ey 7y TEFERT H=5HIZIE. "Run” -> "External Tools” -> "External Tools Configurations...” H
5 "OpenOCD” #:&EIRLFET,

RIZ, *=a—nN—OarIq«FL—arq 2 Foh i, "Organize Favourites” 49 1) w9 LET,
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& C/C++ - M3 /makefile - Eclipse Platform

Elo Edt Sowrce Refactor Navigate Search Run Project Window Help

J:’,:-

Hlﬂolw OJ'C'

'J“-&'I#-OJQQ

le-]nn} P B P

'Ulhomﬁxplofu 82N =0) ‘ﬂml‘ﬁ:i (atsureh hsto
=i # Bun As »
) me # End of default section e
555 bt et coxnter BHRRSBRBRRBRERRARAIRAANAA__SI000R8 Fayorkes. 2’”””“”““””,
&4 Bnaries
& 33 Inchudes EEEEEREEEEEEEEEEREEEEREEEEEEEREEEEEEEEEEEE R EEEEEEEEEREEEEEEEE PR R
[+ ;:L“ # Start of user section
®& o ¥
® § src
%5 io-poet_rom.e¥ - [armfle] ¥
o-poet_rom.bin # Define project name and Ram/Flash mode here
Wosiort Fombaik PROJECT = rest
ket Fomp RUN_FROM_FLASH = 0
lo-poet_rom.srec
& makefie L4
‘Add” &9 vy L, BRLIzav T4 Lb—2avEBRLETS,

& Organize External Tools Favorites

Fayorites:

I

Q)

1 £ Add External Tools Fayorites =10l x|
Add.. Select Launch Configurations:
Remove g &wﬁﬁgmer
g I [4 @, openocoiLibuss) 2
Dowr I

Cancel |

OK" %5 YwH LT, avIq«JL—

YaAaVvERFELEY, CNTHERICAYDHEBY—ILEMASENTESE

To MBY—IWNEFEAZa—N—DoBIRT S LETHEATEEY,

& C/C++ - FM3/makefile - Eclipse Platform

File Edit Source Refactor Mavigate Search Run Project Window Help

Ir-oelple @ -0 % 5|50 ®s (RE -
[ Project Explorer £2 =0 K » makefile 53 4, 1 Mink-GDB-Server
& B 4, 2 OpenOCD
= s = (4, 3 OpenOCD(LbUSE)
=K
525 mbbfxxx_ioport_counter # Define linker script £i  ppg >

#,’;.’ Binaries
#ml Includes
22 ine

#

($ (RUN_FROM FLASH),

LDSCRIPT = ./prj/mbShfs506

External Tools Configurations...
Organize Fayvorites. ..

=
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13  Eclipse CDT DTF/INY TIR—ARY F 4T

OETHYTIDFMI T ) FEMERL. ELEFMASERLIZTD R Ty k774U (*.bin, *.mhx, *.hex) %
Flash ICZ2ZALETEHBELEL . CADDT I Ty b T F7AILICIE, Flash 3 LK IZFRAM TTF/RY S $ 3
EDITBHEBELETFNYTERI 7ML Celf) NEFThTWET,

TNy T ERIRT 51=0I1Z1%, #¥1&IZ Eclipse CDT ® "C/C++ Perspective” h 5 "Debug Perspective” [CEBELFET,
A = a2—® "Windows” H 5 "Open perspective” Z:#IR L. "Debug” %9 'J v LET, "Debug” &, "Other...” I 5

Bl ebTEFY,

re_cm3.h - Eclipse Platform
Broject Run | Window Help
S e s I New Window

et Open Perspective

Customize Perspective., ..

Other... b >
Save Perspective Ais... o=
Reset Perspective... 1199
Close Perspective 1200
Close All Perspectives 1201 /7" \brief I™ ©
Navigation » eonis
1203 This function
Preferences 1204 It returns '1
12085
12086 \recurn
_1ofx]
File Edt Navi Search Run Project Window Help
= 2l [3-0-Q- |5 KD G |§j$nebug |”
%5 Debug 52 | W | S [ 2 7 © O|[0= varisles 52 %0 Ereskponts| AL Eon T
——
=
KT} _>l_J
i, ==
=
# Start of user section
#
Il
#
# Define project name and Rew/Flash mode here
PROJECT = test
RUN_FROM_FLASH = 0
#
# Define linker script file here f
< | »
| Tasks [ 2 Problems | £ Executables | Bl Console 52 O G| Bk B-5-°0
C-Build [mb9bFxocx_ioport_counter]
T oL RO Pt e T HeR =
rm -f io-port_ram.bin g
rm -f io-port_ram.srec
rm -f io-port_rom.elf __]
rm -f io-port_rom.map
A N e 7 |
[[nf Writable Smart Insert | 53119 |
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13.1 OpenOCD #EAL=FAJ S LDOEAHETINYY

JTAG €4 % 7 T —AM 5 SK-FM3-176PMC-ETHERNET 7R— K% PC & USB ##i L T &Ly, J-Link & ARM-
USB-TINY Z#EHB L 1=BlZ FnZEFNLUTIZRLET,

ICE IZ J-Link, ARM-USB-TINY DEE L ZFERALTH., TiETHAT HREEIHBETT,

OpenOCD #i2&ILEF, OpenOCD [ET—EVELTEFTLET, ChlE. Ny I TSH U RFTavy FE#LER
(FTALOUEMEETHLEEKRLET,

LTDEEY., "OpenOCD” 49 ) v LTHEY—ILEEBILET,

& Debug - mb9bfxxx_ioport_counter/src/main.c - Eclipse Platform

- 101 x|
File Edit Source Refactor Mavigate | Search Run Project Window Help
s~ e @ 3 -0 |®F~ |[[ ]85l G0 5 [% vebug ERjCICH+
(3, 1 Mlink-GDB-Server [ Resource
%5 Debug 82 R 8 (e ¥ 2 OpenOCD g ¥ ¥ = O|[9= variables 3 \_%% Braaiq:olnts] x) <k 5 | e G 5]
3, 3 OpenOCD{LibUSE)
Run As »
External Tools Configurations...
Organize Fayorites. ..
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Toary—iLhs, Y—n\HRREn=-CEZHELTEEL,

& Debug - mb9bfxxx_ioport_counter/src/main.c - Eclipse Platform

_— B

File Edit Source Refactor Navigate Search Run Project Window Help

I3~ Gl@|B-0-- @3- [[4]8-l- G-~ &5 [ pobug | BB i+
ff:,Resuurce

%5 Debug 82 i | S i 3 Y T O|[0- variables X\ % Bveakpuints\l 0|5 R &R0

=] % OpenOCD [Program]
#.| C:\OpenOCD_FTDIopenocd-0.4.0\srciopenocd.exe

o P

(Lo makefie  [{cimaing 83 = 0| [z Disassembly 52 =l
e —— Wait l0Op ————m—mm—mm—mm e 4 |1 Mo debug context [Enter location hiere = YR
void wait (int a) =

1 while (a--) ==
b }
|
S NEiN Program —------------=-m & =
< | > il Y
V-l Tasks [E; Problems (O Executables rE Console &2 R ‘3 ‘ B &8 ,E@[ # B-r5--0

'OpenOCD [Program] C:\0penOCD_FTDIopenacd-0.4.0\srclopenocd.exe
Open On-Chip Debugger 0.4.0 (2011-05-05-17:02)
Licensed under GNU GPL v2 %
For bug reports, read
http://openocd.berlios.de/doc/doxygen/bugs. html
jtag nsrst_delay: 100
jtag_ntrst_delay: 100
trst_only separate trst_push pull
500 kHz
Info : device: 6 "2232H"
Info : devicelID: 67353570
Info : SerialNumber: FFSK6HASA
Info : Description: KT-LINK A
Info : max TCK change to: 30000 kHz
Info : clock speed SO0 kHz
Info : JTAG tap: mbShfS506.cpu tap/device found: O0x4ba00477 (mfg: O0x23b, part: Oxbal0, ver: O0x4)
\|Info : wbObf506.cpu: hardware has 6 breakpoints, 4 watchpoints

] o

Al ‘Writable Smart Insert ’49:2 |

-

RIZ, R4 A% halt IREEICL F T, run IKEETIE GDB Y —/3& OpenOCD DI TIS—HWEET H1-0TT,
—SFILIZIaL—% (RETE TeraTerm #FH) TUTDEBYEHELTLEEL,

Tera Term: HLOIEKE @

® TCP/IP R ARD: llocalhost v'

MR @) e o
H 2. ® Tolnet TCPM—r#(P:

OssH SSH/\—3 /() |sSH?

Ot Z0OR2)LC): | UNSPEC v

O T 5 —HR): |COM

oK | FrriL| NILF

WWW.Cypress.com Document No. 002-04422 Rev.*A 71


http://www.cypress.com/

o CYPRESS

- EMBEDDED IN TOMORROW™

FM3GNU V—ILF = — U & A L -REREEERE

“Open On-Chip Debugger’ & R RE M= S EHENARITY,

2 localhost:4444 — Tera Term VI

J7ALE REE FRES 00 DU EIM)  Resize AJFH

Open On-Chip Debugger A

> f
v

‘halt’ A< FERITL. 2—47 v MO halt IREEICHE B &L & RHERLFET .

™ Jocalhost:4444 — Tera Term VT

Zr{E) REE BEES 200 D EOM)  Resize AJLFH
Open On-Chip Debuzger A
> halt E
arget state: halted
itarget halted due to debug-request, current mode: Thread
;;PSRZ 0x21000000 pc: 0x00000168 msp: 0xZ000fff0

#L T, # L < "Debug Configuration” Z/ERLET ., LLTFDE B Y., "Debug Configurations...” 9V v 2 LET,

& Debug - mb9bfxxx_ioport_counter/src/main.c - Eclipse Platform & D]ﬁ]

File Edit Source Refactor Mavigate Search Run Project Window Help

[ Sl -0 - |®2-[4]8 -l G-~ (35 vebug. FEjcjcr+
[© ] 1 Debug-io-port-JLink-GDB | [ Resource

%5 Debug &2 ~ Debugas v | T [0 3 ¥ O)[00- variables 53\ %% Breakpoints| A ElE ]
= @, OpenoCD [Program] Dr:-t%g Configurations...
p.| C:\OpenOCD_FTDIY Orgaize Favorites. ..

L1 _>lj
(,@ makefile (‘FE ggg.g_}g, = E} 22 Disassembly &3 =]
Jd —m e wait loop ——-—-——=——==——====— |7 Mo debug context [Enter lacation here Ell a4 b4
void wait (int a) _1
{
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“GDB Hardware Debugging” Z:&RL. “‘New &7 1) v I LTLIZELY,

FFTNAYTAL T4 T L= 3 F R—LLET, EHADTNAY T AL IT45L—2 a3V EDRERZERITHIz0.
Ja<vx Y b4 (io-port) IZHERY —ILE (OpenOCD) 2 DI H-ARIZIEET D ENHRINTINET,

“Project” [Z1&. "Browse” R4 > % {# 5 T "mb9bfxxx_ioport_counter” L. AHLET,

“CIC++ Application” [Z1Z. "Search Project...” R V& FEWTF TV 75— 3 TNy AT 74ILTEHS "io-port-
romelf’ ZHEELE T,

“Build configuration” IZ1% "Use Active” ZERE L T FF &Ly,

]
Create, manage, and run configurations

\ IIEEE

[€] cic++ Application
[€] Cjc++ Attach to Appicatior
[€] CjC++ Postmortem Debugg
| GDB Mardware Debuggng
[€] Debug-io-poet-Rink-GOE
[€] Debugo-poet-OpenOCT
B Laurch Growp

Nome: | Debugrio-port-OpendCD

R Ma;- bméuooﬂ S M;;B,Sou«.\ [=] ;nunor;l

(TR

,In-pol(_lom off Search Project... Browsa... I
‘]nw”x_nooﬂ_cmer Browse... l

1~ Bulld (F required) before lsunching

7C Zyln Embedded debug (Cygr configuratonD|Def o =
7C 2yl Embedded debug (Natt ! K
(" Enable suto buld " Disable auto buld
@ Use workspace settings Configure Workspace Settngs...

M ——

Fiter matched 9 of 9 kems m fevnt I
|

“Select other...” #4 1) w4 L. "GDB (DSF) Hardware Debugging launcher” »\ & "Standard GDB Hardware
Debugging launcher” IZEIY B2 F T, tIBRE. "'OK"E I ) v I LTLIEEL,
—lolx|

This dialog allows you to specify which launcher to use when multiple launchers are
available for a configuration and launch mode.

[V Use configuration specific settings Change Workspace Settings. ..
Launchers:
GDE {DSF) Hardware Debugging Launcher

Standard GDB Hardware Debuaaing Launcher

[~ Description
Jtag hardware debugging using the standard debugger Framework {CDI).

® Cancel |
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I, "Debugger’ 2 7&ZEINLZEJ ., "GDB Command” [Z[E, "Browse” 1R42 > %> T GDB T/V\y HTdH 3 "arm-
none-eabi-gdb.exe” 77 A1 L%, yagarto DA VA C—IL I+ LA MHMSELIEELET,

“Use remote target” DF v #54 LET,

ll & Debug Configurations

" Create, manage, and run configurations

tEX|E3-

Name: | Debug-io-port-OpenOCD

[€] c/C++ Application
~[E] CJC++ Attach to Applicatior
[] CjC++ Postmortem Debugg:
[ GDB Hardware Debugging
E Debug-io-port-JLink-GDE
i Debug-io-part-Open0Ct
B Launch Group
%6 Zylin Embedded debug (Cygr
3G 2ylin Embedded debug (Mati

m

[ —

Filter matched 9 of 9 items

=] Main [ %5 Debuager @ Startup| &/ Source‘] ] Common |

[~ GDB Setup

GDB G d \
: = -toolchainibin bi-gdb.exe Bvuwse...l \laviables...l

Command Set: [Standard (Windows) ¥ |

Protocol Version: |mi ¥

I™ verbose console mode

ReEote Target

I Use remote targ

SEneric TCR{IP

Host name or IP address: | localhost

Port number: 10000

Using Standard GDE Hardware Debugging Launcher - Select other. ..

Apply. Revert

@)

RIZ "Startup” 4 TEEIRLET,
“Initialization Commands” IZFEE2xaF—LZEY,

load

monitor reset init

# connect to the OpenOCD gdb server
target remote localhost:3333

monitor soft reset halt

“Run Commands’[Z FigZatE—LEd,

Continue

monitor gdb breakpoint override soft
break main
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19 Configurations

maln progeam
1RTIZ ¢ main(vaid)
1

Tey "help
earger remote localbose:3333
CROCOOD000 im o83 InCETEUPT _VECLOE_COETEN B (]

Ho executable file specified.
Use the "file” of "exec-file” commasd.

load S 3 _10poTE \\ do-pore_rom.elf
Loading section .text, size Dxfec lma Ox0
Loading section .ARN.exidx, =size Ox8 lma Oxfec
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TNRYITHRBHTSHE, UTORDOESYIZHYET, BRICIE. "Resume” REZ2EH 1) v o LTLEELY,

it _aport_counter/ st/ main.c - Bclipee Plabfoms =18 =l
Gl Ede Jorce Rafegor foigats Seirch Dot B Bede et
JCi= N B R I P B[ om =
B ety 11 ot e )m | F T g B e 5T O ke varsies | % responts . Mo | L L =hdai=]
G omenocs [Frogram) . v E
o] e D_FTOTjapenacdH. 4. archopanocd s Bl o
(£ Ebnugrio-port-CpenCeCls [ Hardwane Debugong] ez WEFEHG
= 8 00 e e Debagper (511 122 P (MBpended) Hip CO0ETT i
= o Themad [1] (Smparaed: Sagral SIGINT receredd. Descriphion: Intsmugt. ) e 5]
= 2wt i 40 DON00T Bitec CREI
= 3 maind]) w7 wD000CITS Elén (] hod
o Clirsputalygwt ik e (SI911 3:22 P8R al ] =
il workspassimbibf ooc_opert_counberlio-part_rom.ef (/L8 3522 740 E

Lamdale | [f men T OWE] | =
B void wait (imk a) alo
l
|

[
uhile (n--]7
¥

o o

) Tk [ Probiom |03 Exmntabins [ D cormcle 33 () Memiry| B X % lep@® e E-ri-=0
Dy peot-CparT [ s D] g bl o st gt o o (5311 222 PHL
torce soft breakgpoints =

]
[n- T T P |

TNy JER%. "Suspend” iRAEH I TBHIETWDIOTERTTEET,

B
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13.2 RAM TOTF/I\v4

Flash TOT/A\vJHiZ%E 13 1ETHRMALELz, EMZH., TALARORAMANY VY - Ao O0—RLTT/AY
JFBH5ILHARETT . CNICIEMOICRAM 7 U r—2 3 vEERT E2RENHY FF, "C/C++ Perspective”

ITR-2TLEELY,

. —

%Fw& Breupons| 3

“CIC++" &9 1) w9 FBE. IDE (X CICHBAFN—RARI T 4 TIZHY ET, "Make (RAM)” 9 1) v 9§ 5 & T,
RAMAA 98—y hZEILRLRAMT U= a ohERENET (O—FET—2HNRAMDAE Y H A X
FRAGVWESFEELTLEEW),

& C/C++ - mb9bfxxx_ioport_counter/makefile - Eclipse Platform

File Edit Source Refactor Navigate Search Project Run Window Help
| i [ |&-ai-[d-6 - |R-8-|3-0-Q-|® - |l B %5 Debug |G cice+
g8 e
[ Project Explorer 52 = O || & makefile 52 _[S] startup_mbobfs0x_v21 ] L] system_mbobfs0x.c ]»3 = B[ 5= outline [ @) ’ =
8BS Y s [ @ 9B | >
B FM3 1644 -5 FM3
=115 mb9bfxxx_ioport_counter 1654 makefile rules E-5 mbbFxxx_ioport_counter
#;h" Binaries 166 # 2 dep
[ Includes 167 @ inc
& inc 168all: ROM & i
= pri 163 G sre
& src 170 ROM: ASFLAGS += --defsym Debug RAM=0 @ Clean
3&io-port_ram.elf<[arm,lle] 171 ROM: clean §({OBJS) §(PROJECT)_ rom.elf §(PROJECT)_rom.hex -®
i io-port_ram.bin 172 ROM: § (PROJECT) _rom.bin @ make (ROM)
io-port_ram.hex 173 ROM: § (PROJECT) _rom.whx ‘ Program-Flash
io-port_ram.map 174
fo-port_ram.mhx 175 RAM: ASFLAGS += --defsym Debug RAM=1
L[ makefile 176 RAM: clean § (OBJS) §(PROJECT) ram.elf §(PROJECT)_ ram.hex
177 RAM: § {PROJECT) ram.bin
178 RAM: § (PROJECT)_ram.mhx
179
180%0 : %c
181 @ echo "--compiling--"
182 §(CC) -c §(CPFLAGS) -I . §(INCDIR) $< -o $@
183
1584 %0 : %s
185 @ echo "--assembling--"
] 186 $(AS) §(ASFLAGS) $< -o $@
[ 187
188 $ram.elf: §(OBJS)
| 189 @ echo "--linking--"
190 $(CC) $(OBJS) §(LK) $(LDFLAGS_RAM) §(LIBS) -o $@ -
J o
[ Problems (@ Tasks fﬁ Properties ]’@ History (E Console &2 #Debug] Lo ’g' CH BE Bk ‘ B T 0
C-Build [mbSbFxxx_ioport_counter]
==IIORLOg-— =l
arm-none-eabi-gec-4.5.2 ./sre/main.o ./sre/core_cn3.o ./src/systen _wbSh£50x.0
./src/s:arr.up_mbgbfsox_vzl.o -static -mecpuscortex-m3 -mthumb -mthumb-intervork -nostartfiles
-Wl,--start-group -lc -lg -lstdce++ -lsupc++ -lgee -lm -Wl, -—end-group
—T./prj/Fujitsu_cortex—MG_ram_VZl.ld -Wl,-Map=io-port_ram.map,--cref, --no-warn-mismatch -0
io-port_ram.elf
arm-none-eabi-objcopy -0 ihex io-port_ram.elf io-port_ram.hex
arm-none-eabi-objcopy -I elf32-little -0 binary io-port_ram.elf io-port_ram.bin
arm-none-eabi-objcopy -0 srec io-port_ram.elf io-port_ram.mhx J
< | | E
e

U
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“Debug perspective” IZRY . RAM T/3w 5 ZBBLET,
S R

;vaQ-J@é"’vJu 1l . Erlﬁqc++

f\g Resource

(O—
= E] S-_- Outline |

=Io GOkl =

=115 mhahfyvy innark cannker

PC & SK-FM3-176PMC-ETHERNET h— FZBEHE L E I,
HiEf%k. OpenOCD ##BBILE T, UTDEEY., "OpenOCD” #5 )w o LTHEY—ILEZRBELET,

& Debug - mb9bfxxx_ioport_counter/src/main.c - Eclipse Platform = Dlﬂ
File Edit Source Refactor Mavigate | Search Run Project Window Help
o5 - e|E [0 - Q@ 9 [ S]] f1 k] G £ [$5 oebug. icicrr
2, 1 ink-GDB-Server [ Resource
35 Debug 53 BT X v ©9= Variables 52 %% sreakpoirts] La0lE R % =0
{3, 3 0penOCD(LibUSE)
Run As »
External Tools Configurations...
Organize Fayorites. ..

Toary—iLhho, Y—n\HhRREShi=C e ZHREL TS,

€ Debug - mb9bfxxx_ioport_counter/src/main.c - Eclipse Platform

i

Fle Edit Source Refactor Navigate Search Run Froject Window Help

-G @@ 3 -0-- @8- [52G4l o-n- 3% owny FRicice:
(7 Resource

%5 Debug 2 % o7 Or (1 m 0% | S [ i% 3 7 = O)[c0- variables 53\ %% Breakponts LaBlsf %R0

& @, 0pen0CD [Pragram]
s C:\OpenOCD_FTDIopenacd-0.4.01srclopenocd.exe

« o
[Lomakefie [icimane 23 = 0|2 Disassembly 52 =g

/7 wait loop & |0 ||Mo debug context [Enter location here =l n BT
void wait (int a) =l

{
while (a--); =l
ol

b main program ----

& v
< | _’l_l 1] _>l_|
V| Tasks rﬂ"iwuhlemsfo Executablx{ﬂ Console &2 R 1T EE[E@| #B-r5-=0
OpenOCD [Program] C:10penOCD_FTDIopenocd-0.4.01srclopenocd.exe
Open On-Chip Debugger 0.4.0 (2011-05-05-17:02) A
Licensed under GNU GPL v2 k
For bug reports, read
http://openocd.berlios.de/doc/ doxygen/bugs . html
jtag_nsrst_delay: 100
jtag_ntrst_delay: 100
trst_only separate trst_push_pull
500 kHz
Info : device: 6 "2232H"
Info : deviceID: 67353570
Info : SerialNumber: FFSK6HASA
Info : Description: KT-LINK A4
Info : max TCK change to: 30000 kHz
I Info : clock speed 500 kHz
| Info : JTAG tap: mbSbES06.cpu tap/device found: 0x4ba00477 (mfg: Ox23b, part: Oxba00, ver: Ox4)
| Info : 1bSbES06.cpu: hardware has 6 breakpoints, 4 watchpoints

Ei]

M

Writable SmartInsert | 4912 |
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#1 L < ”Debug Configuration” 4 LET ., LLTD EFH Y. "Debug Configurations...” #21) v o LET,

& Debug - mb9bfxxx_ioport_counter/

‘main.c - Eclipse Platform

-0 x|
File Edit Source Refactor Mavigate Search Project Run Window Help
Jrj- j@J:};’;.O.Q-]@@“.J ‘J;.’_.v¢ = [ | %5 Debug »
5 2 % [© ] 1 Debug-io-port-JLink-GDB-RAM l i% 2 Y 2 O)[09= variables 2 % Breakpoints] Z) ok 0 | & % % v 0
= % oCD [P [ ] 2 Debug-io-port-OpenOCD
3] C:\OpenocD_FTDn, (£ 3 Debugrio-port-Link-GDB
=
v
K| »
Ag) main.c 83 =0
void wait (int a) AID
{
while (a--) ;
} ==l
o wEin Program ———————————————
& int3z_t main(veid)
{ -
K| »
V| Tasks ﬂfd Problems ro Executables rE Consale &3 - R | x gglﬁual = B8-ri-708
OpenOCD [Program] C:\0penOCD_FTDIopenacd-0.4.0stclopenocd. exe
trst_only separate trst_push pull 3
500 kHz
Info : device: 6 "2232H"
Info : deviceID: 67353570
Info : SerialNumber: FFSK6HASA
Info : Description: KT-LINK &
Info : max TCK change to: 30000 kHz
Info : clock speed 500 kHz
Info : JTAG tap: mbSbfS06.cpu tap/device found: 0x4ba00477 (mfg: 0x23b, part: Oxbal0, ver: 0x4)
Info : mbSbf506.cpu: hardware has 6 breakpoints, 4 watchpoints |
v
kil [

|

EG

Writable

Smart Insert 48511, J
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“GDB Hardware Debugging” ##EiRL. “New” 9 U v LET,

FNRyFaAv T4 L—2avE ) R—LLET, RAMTNY S & Flash TNy T &R +21=6H, Y7199
127 RAM” 2D THRIZBRBESNTVREADTNY T AV T4 5 L—a v EDRRAER#ITET,

“Project” [Z1&. "Browse” R4 > % {# 5 T "mb9bfxxx_ioport_counter” L £ 3,

“CIC++ Application” [Z1. "Search Project...” RZ V& FE>TTF7 T U =23 TNy HI 744 IILTHS "io-port-
ramelf’ Z#EELE T,

“Build configuration” IZI& "Use Active” & "Disable auto build” ZEE L TL FZ& LY,
i

Create, manage, and run configurations

05T 1}

[ ROR RS ;Nm:ll)ebuq»n-oat-o;amoco-km

[evoe fter test I ) Man 35 Debugoer | B> Srtup| 15, Source| [ Gommon |

] Cic++ Appheation Al

] €+ Attach to Applcation | | S Apication:

] CiC4+ Postmortem Debugger fqﬂw) chbml Browss... I
| GDB Hardware Debugging Progact:

[€] Debug-o-port- Rink-G08 | mbobeoo .
(€] Debug-o0-port-Link-GOB-RAM uﬂi“ﬁ@ Liiyowse.. I
(€] Debug-o-port-OpenOCD I [ Bulld (F required) before launching :
(€] Debug-o-port-OpenOCD-RAM M =
‘L e | Bulld configur: Use Active :]

¢ Zyln Embeddad debug (Cygwin)
: 2yin Embedded debug (Native)

q 0
Eier matched 11 of 11 kems | @mmwm@ e L |
@ T
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“Select other...” %% 1) v~ L. "GDB (DSF) Hardware Debugging launcher” /% “Standard GDB Hardware
Debugging launcher” IZEIY BZET, UIBZE. 'OKZI ) v LT,

& Select Preferred Launcher ) = B

This dialog allows you to specify which launcher ta use when multiple launchers are
available For a configuration and launch mode.

IV Use configuration specific settings Change Workspace Settings. ..
Launchers:

B (DSF) Hardware Debugaing Launcher
Standard GDB Hardware Debugaing Launcher

[~ Description
Jtag hardware debugging using the standard debugger Framework {CDI).

RIZ. "Debugger’ 2 7Z&ZERLZEF, "GDB Command” [Z[E, "Browse” R% > %E>T GDB F/N\y HTH
% “arm-none-eabi-gdb.exe” 77 4 JL%&. yagarto DA VA =)L 7+ L EHLIELIEELET,

“Use remote target” DF v I 54 LET,

& Debug Configurations

" Create, manage, and run configurations

x|

¥

[©] Debug-io-port-JLink-GDE

[] Debug-io-port-Open0OCT Command Set: |Standard (Windows) ']
B Launch Group
3G 2Zylin Embedded debug (Cygr Protocol Yersion: |mi 'I

26 2ylin Embedded dsbug (Nat
I™ Verbose console mode

[5[E % ‘ =30 fame: | Debug-io-port-Open0OCD
| | =] Main [ %5 Debugger (= Startup] ¥ Source| gommon]
s CJC++ Application ~GDE Setup
[] CjC++ Attach to Applicatior DB Command:
[E] cic++P Debugg:
: . - -
=[] GDB Hardware Debugging [ty garto-toole -gdb.exe

Browse... | Variables... I

[~ Remote Target
I~ Use remote target

374G Device: [Generic TCR/IP 2

Host name or IP address: | localhost
Port number: 10000

[ —

Filter matched 9 of 9 items

Using Standard GDE Hardware Debugging Launcher - Select other...

Apply Revert

@
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RIZ "Startup” 2 TEEIRLET,
“Initialization Commands” [T FE2ZaE—LZET,

# connect to the OpenOCD gdb server
target remote localhost:3333

monitor reset init
monitor reset halt
monitor soft reset halt

# Vector table placed in RAM
monitor mww OxEOOOEDO8 O0x1fff0000 ———V RAMDRXA—FF7 KL X

ERE

load

“Run Commands” [T FigZabE—LET,

break main ARBYDRA B
set $rl13 = *(int*)O0x1fffE000 — | DF7FLR

*
£ Spc = * (int*)O0x1fff0004 *—0 -
S O RAMDZ S — L7 FLR
+4 ZERTE a

ENETIAILFOEERELTLESL, "Debug’ £5 v o L. TAYTEBEBLES,
51

Create, manage, and run configurations ﬁ

7 Name: | Debug-io-port-OpenOCD-RAM
1] Main ﬁ,‘& Debugaer fb Startup . Source | ] Common |
[c] c{C++ Application i ion Commands 21

[E] i+ Attach to Applicatior || || 7 Reset and Delay (seconds): [3

[€] cjC++ Postmortem Debugg: 7 ot

[€] GDB Hardware Debugging s
[€] Debug-io-port-ILink-GDE # connect to the OpenOCD gdb server 3

5] Debugio-port-Link-GOE target remote localhost:3333
monitor reset init

Debugrio-port-Open0CL ||| | | monitor resst hakt

[©] Debug-io-port-Open0Ct |
B Launch Group
3G Zylin Embedded debug (Cyg
3G Zylin Embedded debug (Nati-

0}

[~ Load Image and Symbolk
IV Load image

% Use project binary: io-port_ram.elf
1 Usefile: [
Image offset (hex):

IV Load symbols

Workspace,.. || File System.,

% Use project binary: io-port_ram.elf

" Use file: [ Workspace:
Symbols offset {hex):
[~ Runtime Options.
I Set program counter at (hex):
I Set breakpaint at:

File Systemi .

I” Resume
[ Run Command:
break main |
continue
-
M=
[ —
v - Using Standard GDB Hardware Debugaing Launcher - Select other... Apply. Revert
Filter matched 11 of 11 items
@ Cor)_o=
‘ARV

WWW.CYpress.com Document No. 002-04422 Rev.*A 82


http://www.cypress.com/

EMBEDDED IN TOMORROW™

FM3GNU V—ILF = — U & A L -REREEERE

RAM TRy AT 2L, UTORDESYIZHYET, BRICIEX. "Resume” RE2VEH ) v LTLESLY,

€& Debug - mb9bfxxx_ioport_counter;/ i lipse Platform 9 [=]
Fie Edit Source Refactor Navigate Search Project Run Window Help
[ o= |@lss-0-Q-|®s-| 5]|F -Gl oo- - &35 Debug >
%5 Debug 2 S s Rl ® 3@ E [0 3 7 T O[00= Variables [0 Breakpoints [ ! Regiters 3 =k Modues @
5G4 Open0CD [Program] I Name. | value |
i » C:{OpenOCD_FTDI\openocd-0.4.0lsrclopenacd.exe !.m 23
=[] Debug-io-port-OpenOCD-RAM [GDE Hardware Debugging] 0x20007ff8
1-&® GDB Hardware Debugger (5/9/11 6:29 PM) (Suspended) 536839815 i
=g Thread [1] (Suspended) Ox1FFf8153
: = 1 main() main.c:54 Ox1FfF8152 0
b ,5 C inibir bi-gdb.exe (5/9/11 6:29 PM) 0 ha
o C: _ioport_ io-port_ram.elf (5/9/11 6:29 PM) < | B
i} y
= =8
int3z_t main(void) |
€
FH3_GPIO->ADE = OXOOFF; // No inalog Inputs
FM3_GPIO->DDR1 = OXFFOO; // P18-P1F: LED-SEGL output —
FM3_GPIO->DDR3 = OxFFOO; // P38-P3F: LED-SEGZ output
FHM3_GPIO->PFR1 = 0x0000; // P10-P1F: LED-SEG1 GPIO _I:J
v
@rads {2 Problems | £ Executables ﬁMﬁB BMzmnrﬂ CEE {5‘@‘ B a-r-=
Debug-io-port-OpenOCD-RAM [GDE Hardy inibi bi-gdb.exe (5/9/11 6:29 PM)
-
#monitor gdb_breakpoint_override soft
Undefined command: "". Try "help”.
break main
Breakpoint 8 at Ox1£ff8152: file sre/main.c, line 54.
continue
Breakpoint 1, main () at src/main.c:S4
54 FM3_GPIO->ADE = OxDOFF; // No Analog Inputs
4 ¥

Writable | Smart Insert | s4:1 |

“Disassembly” M5, BMADA VR +SU L 3 EHRETEET, "Window” A =2 —5H 5 "Show View” Z:EIRL T
< 12: ES L \o

bhxxx_loport_c tckpse Platform =101 x|
Bl m Source Refocior Navigste Sexrch Brojct Bun Window b
Jr3> SIS E - S0 B30 SOAN B S AR i 1 petug o
%5 Debu 23 A¥t>» 8 2D xI| PRS0 <« =27 =0
= @ Openc<D [Program] -
W CiopenoCD_FTDNopencd 0.4, Olsreiopenocd exe
8 %mwvmmmommw =5
= P Threod (1] (Suspended: Sional SIGINT recetved. Descrotion: inbermupt.)
2 wor() man.c:40 Ox1Aff8144
1 man() man.c:71 Ox1FICED -
o (59111 629 ) ] 2
2 Cilworkspaselmbiiblocs _opoet_sourbero-port_ram e (5/9/11 6:2550) =

void wait (int a)

I 1dr €2, [ap, #4)

..u,(.__), add.v r2, r2, K4294967295

N frt =—=mmeee WOIN PrOgram ———-m=meeemmeme
4 1ntdz_t main(veid)

12228148:
a9 )

boe.n Ox32£28132

<waites>

- J 1222814a:  aad 3p, A8 _]
FN3_GPIO->ADE = OXOOFF: // No Ansiog I 914 bx i€
e t222814e:  mep
FH3_GPIO->DDRI = OXFFOO; 53 !
FNI_GPIO->DDRI = OXFFOO: main:
- 12228150 push (r3, lo)

s GPKO->PFVI - 01(0000:

FR3_CPIO->ADE = OxQOFF: // No Analog Iap

: AL..M.‘.. BT . avanan :I:J

B x| lepS@E 20-05-20

<
fa'-.l.‘m.. Exearaties | B Corscle 33 () Memary |
AR X _Kpoet,

LU

| Wekatie | Smatinot 4811
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14

Eclipse Embedded Systems Register View 73544 >

Eclipse @ "EmbSysRegView’ 7554 VIEFM3 DI RTHERDR Y Iz SV LPRAERTLIRETEET,

TS5940DA VR =L

"EmbSysRegView” 73454 > % Eclipse 24 VR b—IJLTF Bf=HIZ. A =a—0 "Help” i 5 ’Install New

Software...” ZEIRLFT,

M_

(::;\ Welcome . 4
(7) Help Contents
% sgarch
Qynamic Help [
Ctri+Shitst

Tips and Tricks...

Chexck for Undates

About Echpse Platform l

“‘Add” RAE %9 v o L, "Name” 2 TS5 4 L DAFTE AN (Bl Z £ EmbSysRegView) L. "Location” IZIETF

D URL ZHEL T &L,
http://embsysregview.sourceforge.net/update
fEREE, OK"ZV Vv I LET,

& Install

Available Software
Select a ske or enber the location of a site.

Workwith: | type or select & ste

Find mare softuware by working with the “Avaisbls Software SKes™

Name | sarcinn

IORCTIIRTEmm  idnepontony
Name: | EmbSysReqiiew Local... |
Locakion: | http:{fembsysregview. sourcefirge. netjupdate Archive... |
I ==
| Select &l Desehect Al :
I—Dd.di

" % Show only the Iatest versions of avadoble software
i ¥ Group Rems by category
" ¥ Contack llupdate skes durng installto find required software

™ Hide tenms that are slready instalbed
What s gready instabed?

'@
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FTRTDTSTAVEBIRLT Next’ 9 v LET,

& Install

(=] |
Available Software

Check the items that ish to install. - ]‘
eck the items that you wish to instal \\"_’) -

Work with: | EmbSysRegView - http: ffembsysregview.sourceforge.netfupdate L’ add... |

Find more software by working with the "Available Software Sites" preferences.

filter text

MName I Yersion ]
000 embsysregview
4 embsysregview_feature 0.1.8

Select Al I Deselect All 1 item selected

[~ Details
=

[V Show only the latest versions of available software ™ Hide items that are already installed

¥ Group items by category What is already installed?

|V Contact all update sites during install to find required software

® < Back I Mext > I Einish Cancel

‘Next" 9 ) v LTA VR C—LOFMEHEALET,
e _lgix]

Install Details

I -
Review the items to be installed. |

MName | Yersion I Id |
L4 embsysregview_feature 0.1.8 org.eclipse.cdt.embsysregview_feat...
Size: Unknown
i i Details
=
=

® < Back

Eiriisty Cancel
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A4t REHEFE L. 7l accept the term of the license agreement” [CF = v 9 # At “Finish” TO« Y K9 ZBELFE
ElS

e gl

Review Licenses l_‘[
Licenses must be reviewed and accepted before the software can be installed. \;_)) i

License text (for embsysregview_feature 0.1.8):

EmbSysRegview is free software: you can redistribute it andfor Z|
modify it under the terms of the GNU General Public License as

published by the Free Software Foundation, either version 3 of

the License, or {at your option) any later version.

EmbSysRegview is distributed in the hope that it will be useful,

but WITHOUT ANY WARRANTY; without even the implied warranty of

MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the

GMU General Public License for more details,

You should have received a copy of the GNU General Public License

along with EmbSysReg¥iew. If not, see &t;http:/fwww,.gnu.orgflicensesf&gt;.

(‘{ktll accept the terms of the license agreement:

do not accept the terms of the license agreement

@ < Back | Iext = | Einish I Cancel

Eclipse ZHi#28 L E 9, "Restart Now” 22 1) v o LTL &Ly,

& Software Updates ] x|

¢ , Youwill need to restart Eclipse Platform for the installation changes to take
\./ effect. You may try to apply the changes without restarting, but this may
Cause errors.

Mok Mow Apply Changes Mow

Z N T, "EmbSysRegView’ D4 VX k—ILHBET T,
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14.2 Register View OfEMA

FM3DRYITISIWLPREDE 2—%HHR— T B=HIZE. FMSAD xm 7274 ILE 2 DERTILELADHY
FF, Axml 77 A IIVEAETHERATEZYV I b7 Ry r—JICEFTNTWSDT, Eclipse 7554 74 ILE
IZaEF—LTLESL,

Eclipse D4 YR b—IL 7+ L FEUTDO &L 3 GBEIZHE>TVET,

Address Ciheclipse
Mame = | Size I Type | Date Modified |
[-2) configuration File Folder 5/25/2011 1:30 PM
|) dropins File Folder 9/9/2010 11:52 AM
[C)features File Folder 5/25/2011 1:04 PM
D2 File Folder 12/6{2010 10:38 AM
File Folder 5/25/2011 1:04 PM
(C)readm File Folder 1216/2010 10:29 AM
.eclipseproduct 1 KB ECLIPSEPRODUCT File 7/29/2010 11:37 AM
| artifacts, xml 54 KB XML Document 5/25/2011 1:04 PM
= eclipse.exe 52KB Application 8/10/2010 5:48 PM
Beclipse.ini 1 KB Configuration Settings  5/25/2011 1:29 PM
Eeclipsec.exe 24 KB Application 8/10/2010 5:48 PM
@epl-vlo.html 17KB OperaWeb Document  2/25/2005 7:53 PM
notice.html 9KB Opera'Web Document 4/27/2010 4:23 PM

plugins 7 # LA ZBE. 4 >R k—JL L 1= “EmbSysRegView’ 75514 DA VA =L T 7 A ILEELET,

address | Cieclipse Address I C:\eclipselplugins

Name Mame + l
[5) configuration () com.zylin.embeddedcdt_4.16.1

() dropins |yorg.apache.ant_1.7.1.%20100518-1145

[C)features () org.edipse.cdt.core.win32_5.2.0,201009241320

Dp2 [ or o). ecli e.cdt.em 0.1.8

B plugins () org.edipse. cofé. runtime, compatibility registry_3.3.0....
[C)readme () org.eclipse.equinox.launcher . win32.win32.x86_1.1.1....
.eclipseproduct () org.edipse.platform_3.6.1.v201009090800

|2 artifacts.xml () org.edipse.ui.intro.universal_3.2.402.r36_v20100702
= eclipse.exe | org.edipse.ui.workbench. compatibility_3.2.100.12010...
3 eclipse.ini M com.ibm.icu_4.2.1.v20100412.jar

Feclipsec.exe [ﬁ] com.jcraft.jsch_0.1.41,+200903070017.jar

@ epl-v10.html E] fujitsu.embsysregview. jar

notice.html M javax.servlet.jsp_2.0.0,v200806031607.jar

|_.g] javax.servlet_2.5.0,v200910301333.jar
[ﬁ] org.apache.commons.codec_1.3.0.v20100518-1140.jar
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T+ I EEBE, ¥Ydata¥cortex-m3 DI A ILFRIZEH LWLV T+ ILF (Bl Z X Cypress) #ERLET,

o LNG LUl REYR L GYUIRGS  JUuis LG

O 80w -0 0w-0 19
Address 1D Cre | eress [ crtecle Address |

MName =«

/‘j Search || Folders | =y (3 x n ‘ v

Cileclipse\pluginsiorg.eclipse.cdt.embsysregview_0.1.8\datalcortex-m3

Eadata Elarne— | Name | Size | Type |_Date Modified
icons [D)cortex-m3 {EnergyMi File Folder 5/25/2011 1:04 PM
(CIMETA-INF lgj LuminaryMicro File Folder 5/25/2011 1:04 PM
s CmxP File Folder 5/25/2011 1:04 PM
= contexts.xml L) STMicro File Folder 5/25/2011 1:04 PM
L'g} jdom.jar
{ﬂ miglayout-3.7- View >
= plugin.xml

Arrange Icons By »

Refresh

Customize This Folder...

Paste
Paste Shortcut
Undo Move Ctrl+Z

§hor§cut {

Properties o]

a Briefcase |

Cypress 7 #+ LA {4k, "embsysregview.dtd” & "MBOBF506N.xmlI” DEAD I 7 A LEBEET,

e Edb  Yew Fa| Fle Edt View Favorites Tools Help

@Back - \Q \ eBack - \Q - ’ }/:\’ Search || Folders ’ i';; K x n ‘ B

Address I’b Cieclipselr | Address C:\eclipse\plugins\org. eclipse.cdt.embsysregview_0.1.81data\cortex-m3\Fuijitsu

Name * Mame -~ | size | Type | Date Modified

i@ EnergyMicro 2KB DTDFile 9/23/2010 3:35 PM
(Fujitsu 744 KB %ML Document 4/19/2011 2:04 PM
[y LuminaryMicro

Cnxp %

) STMicro

Eclipse IDEIZRY., 41 VA F—ILLELPRAE2—%EALEY,
A = a— “Window” /5 "Preferences” #BE £,

Project | Window Help

o ew Window .
g J Iiew Editor - J &

. OpenPerspective | 2
Show View »

Customize Perspective...
Save Perspective As...
Reset Perspective...
Close Perspective

Close all Perspectives

Mavigation »

ETEE—
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UTOEDOESIZHERYT S

—_

T/\

[oger 1

Appesrance
& Build

£ oen 2

Breakpoint Actions

Common Source Lookup Path

Debugger Types
Disassemb
EmbSys Register Yiew
OB
GDB MI
Tracepoint Actions
- Editor
File Types
Indexer
Language Mappings
Mew CDT Project Wizard
Property Pages Settings
Task Tags
Template Default Values
[+ Help
InstallfUpdate
[ Run/Debug
[ Team

=&

A REERLET,
=101 %]
EmbSys Register View >
& Periperal Register Yiew for embedded system
Chip description
thsx-ms ﬂ L
I\'endur: .
||Fujitsu ;I 4]
Chip:
6
ooard;
I nons d
| | |

@

===

LPRAEL—DaAV T4 L— 3 URER%K. Y—ILEFERALET, COTDT/NAY I /IR—ARY T4 T (I
BEESBBEIV) A LIREE1—%#<IZIE, "Window” -> "Show View” -> "Other...” &R L F T,

i Project | Window Help

G- |

Mew Window
Idew Editor

Open Perspective

Show View

»

Customize Perspective. ..
Save Perspective As...
Reset Perspective. ..
Close Perspective

Close All Perspectives

Mavigation

v

Preferences

@] CJ/C++ Projects
=] console
Include Browser
Make Target

- Mavigator

& @

5% Outline

[2 Problems

[ Project Explorer
| Properties

<" search

3 Tasks

Alt+Shift+Q, ©

Alt+Shift+Q, ©
Alt+Shift+Q, %

Alt+Shift+Q, 5
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“Debug” i 5 "EmbSys Registers” #:ER L. "OK" &9 1J v LTLZELY,

=10l x|

|»

= Debug

-@g Breakpoints
ﬁ Debug

Disassembly

b i
3 0 Executables
. 5,}“‘ Expressions
ﬂ Memory
B, Modules
330 Registers
5% Signals =
-8 Trace Control
()= Yariables

#-(Z Help L.l

q_E I Cancel |

TN T, TL—IRA VP TEFTER MY TLBBRLELSRADELZHERTEES, LOREZEZFTLI )Y
DB ETHENEL—2FBTEFT, BRLAELDPRAZBAXFIZHYET, LORIDEEER S ERFICH
YET, YVRARSA B EZLORBICEDEDE. LYVREIDEWRAZRSZENTEET,

ipse Platform > =10fx|
Ele Edt Source Refactor Navigate Search Run Project Window Help
Ir5- [Gl%-0-a-l@v-| 4l nic - 53 oen Eicices
35 Debug 53 Wb | B |2 @ =% 3 7 O)(00- verisles [iit Registers 53 2 Modules| 0 Y =0
-G Open0CD [Program] Name | value A
55 C:\OpenOCD_FTDIjopenocd-0.4.0lsrclopenocd.exe = et Main —
=[] Debug-io-port-OpenOCD [GDB Hardware Debugging] uro 373
-89 GDB Hardware Debugger (5/25/11 2:54 PM) (Suspended) it 1792
4P Thread [1] (Suspended) e e _j;‘
= 1 main() main.ci54 000000176 | LB
i ¢ bi-gab.exe (5{25/11 2:54 PM) =
+ Cilworkspaselio-portiio-port_rom.elf (5/25/11 2:54 PH) 1] S
6] main.c 82\ = 0| [z Disassembly 23 [ Enter location here =8 B~ =0
50 Al ||» 0ooo0176: | mov.w r3, #12288 ; 0x3000 Al
[SULE s WD PEOYCENY: = 0000017a: movt r3, #16387 ; Ox4003 =
52 int32_t main (void) 0000017e:  mov.w r2, 4255 ; OXEf
53 ( — || oooooisz:  str.w rz, [r3, $1280]  ; Ox500
2054 FH3_GPIO->ADE = OxOOFF; // o Analog Inputs 56 FM3_GPIO->DDR1 = OXFFOO: // P18-P1iF: LED
55 - 00000186:  mov.w r3, #12288 ; 0x3000 =
4 Tasks [[2. roblems [ Executables | I Console B0 Embsys Reisters £3 (0 Memory | =
\Arch: cortex-m3 Vendor: Fujitsu Chip: MBSBFSO6N Board: -~ none -—-
Register | Hex |&in | Reset |_Access | address | Description S
® (& ADC1_12bit The 12-bit AJD converter is a function that converl
® (& ADC2_12bit The 12-bit AJD converter is a function that converl
B (= EXTI The functions and operations of the external inter
B (= InterruptSourcecheck The interrupt controller determines the priority of
B & 6PIo General Purpose 1/0 Registers
B & 10_PORT
& & prro 1111 R The Port Fucntion Setting Register 0 selects the us
(=] poo (bit 0 oxt 1
(=] ot bit 1) ox1 3 =
I W S E—
=] pos N 3) 0x1 1
[=] po4 (bit 4) ox1 1
(=] pos (bit 5) 0x0 0
(=] pos (bit &) 0x0 0
(=] po7 (bit 7) 0x0 0
[=] poa (bit 8) 0x0 0
(=] pos (bit 9) 0x0 0
% POA (bt 10) 0x0 0
POB (bit 11) 00 0
(=] Poc (bit 12) 0x0 [
(=] poo (bit 13) 0x0 0
(=] pok (bit 14) 0x0 0
(=] por bit 15) 0x0 0
g BT e | oW AT The oy B St o e '“_Ill

I [
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15  Eclipse D%

151 #HE
Eclipse CDT [&. 2 —H M FM3 Q#AH LR T LK ET HI2HZYVELDOY—ILOEEERE >TLET,

AETHR, TNV ITNR—ZARY T4 TTHEATEDY—ILEBNLET,

15.2 Disassembly Ea—
COT TN T NR—=ZARY T4 T FHHIEL13FEEZSRZELY) O "Disassembly” E 2 —&RTFY 5F=&HIZ(F, A
— 21— "Window” -> "Show View” -> "Disassembly” Z:#iR L £ 3,

Run Project | Window Help

; 5 New Window o=
s J = New Editor N -
ﬂ Open Perspective » ((x): Yoriables ES\_—
Show Yiew d 9o Breakpoints alt+Shift+Q, B
:E:;’;;Z']e"e Customize Perspective.,, = Console Alt+Shift+Q, €
-PM) (Suspende Save Perspective As... ‘ﬁ} Debug
Reset Perspective. .. -t e
I Close Perspective ) Executables k
rone-eabi-gdbi Close All Perspectives & Expressions
5125111 2:54 PM Navigation » a Memory
ujitsu_cortex-p: Er eferences ?‘ Psuos
0= Outline Alt+Shift+Q, O
P {2 Problems Alt+Shift+Q, X
7o) Registers
5% Signals
!/ No Analog Inputs | Tasks
" - s €% Trace Control
) TR LIS s s
Other... Ale+Shift+Q, Q
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Ea—F. UTORDEBYRTENET,

Dot £3 XM > BB = h T © D)0 verubles 12 N s Xm= 0]
= Q) OpenXD [Frogram) N | vohun
»il CriOpenOCD_FTDNopanocd-0.4. Oharclopanced exe
& [T Detwgro-port-OpencCD [GDB Mardware Debugang]
2 @@ GOB Mardware Debugger (S{25/11 2:54 PM) (Suspended)
= 4P Theesd (1] (Suspended)
= 1 man() man.c:54 (hD0000176. :
» Ciiyagartolyagarto-tookhsnibins smrnone-eabi-gdb. exe (5/25(11 2:54 PM) =
i Ciiworbspaselio-portlo-port_rom.ef (S5/25/11 2:54 M) p »
[@ e = S e e ol & ooty 13 Cotw oo bare s mls ==0
VIUDVLVET nop &
Uf 7 emmsiddecsenens BN LTS ~—v=cecvcncskuce main:
SAntdZ_t main(void) 5 ¢
%11 00000174: push (r3, Ir}
i FHS GPIO-SADE = OxOOFF: // Mo Avalog fnputs 54 FH3_GPIO->ADE = OxOOFF: // %o Analcg Inp
g8 - % 00000176:  mov.w £, §12288 3 0x3000
54 FE3 GPIO->DDR1 = OxFFOO: 000001 7a: move r3, #16387 : Ox4003
57 ,.!3'6,10_,»”33 - OxFFOO; 0000017e: mov.v r2, #255  Oxtg
¢ - 00000182:  ste.w £2, (r3, #1280) ; OxS00
©5  FEN3 GPIO->PFRL = Ox0000: s6 FH3_GPIO->DDRL = OxFFOO: // P18-PiF: LED
FH3 GPIO->PFR3 = Ox0D000: 00000186:  mov.v £3, §12288 ! 0x3000
- 0000018a:  movt £3, #16387 : Ox4003
FE3_GPIO->DDRS = Ox0000; // Pi8~PiF: SU2-INTO, S@3-INT) 0000018e:  mov.w r2, §65280 : 0x2200
‘ 00000192¢  ste.w £2, {r3, WS516) : Ox204
54 FR3_GPIO->PFRS = Ox0000; // Pi0-PiF: SU2-INTD, SWi-INT1 57 TEI_GPIO->DDRS = Ox¥FOO: // P3B-PIT: LED
55 - 00000196 mov.v £3, M12288 ; 0x3000
while (1) 0000019a:  move &3, F16387 : Ox4003
87T 0000019e: mov.v £2, #65280 ; Ox2200
¢ FH3_GPIO->PDORY = LEDPATTERN(count / 10): 00000182 : acc.v £2, (r), WN524) ; 0x20¢
05 PNI_GPIO->PDORS = LEDPATTERN(count - ((count / 10) * U it FEY:CRI0->PERL 8. OX0000;. 7/ D10-218: LL
¢ 000001a6; mov.v ©3, #12208 ; 0x3000
P watr  £10AOKAA) - 1L nte movemn o S 2 000001aa;:  movt 3. #16387 : 0x4003 d
= | S J | afs
F 20t 112 Cvnbdareis 1% Cvar dblas | 1=) Fonrole | TR €bsiinn Dasisbansi 830 em

A—HFIXNDTE "Suspend” RE U EHV Y I FTBHIETIL—YEIEEHIENTE, TL—IBDAIVRARSY
avIZRA U MEHETET, TV SLERTSES "Terminate” R2 D ERBBREZRWT LS,

,,<}a : @':'Q{)|i¢’.ﬁz
Resume {FS |Step Into {F5}| /‘\hnst'uchon Stepping Mode|
Step Over {FE}

|Tv.=_-rm|r|ate {Ctrl-l-FF_'}| |Step F‘.Emrn {F?}I|
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15.3 CPU Register E a—
Eclipse COT &, A7DL YR ZITY—FHELKETA DTV EANTEET,
“Window” -> "Show View” -> "Register” ZER L TL &Y,

: | Window Help

5 New Window o .
)_ New Editor S
@ = Yari
= Open Perspective > ((x) Variables —
ow View d ©o Breakpoints Ale+Shift+Q, B L
Customize Perspective. .. E] console AltShift+Q, €
jo  5avePerspective fs... %5 Debug
Do Reset Perspective... == Disassembly
Close Perspective (3 Executables
Close All Perspectives GF Expressions
‘€ Navigation » [J Memory
- s
p Preferences B, Modules l Ente
= D% Outline Alt+shift+Q, 0 [~
counter for LED disyp E,. bl le+Shif
count Biresrion ( Problems Ale+Shift+Q, X @
TN
___________ &% Signals
- Tasks P
€2 Trace Control , #
(9= Yariables Ale+Shift+Q, ¥
r3,
Other... Ale+Shift+Q, Q r3,

TRTDATZDLCAEEFDEERTLET, A7DLICREERBIZIE’Main” V) —ZBENTLEEL,

(%5 0ebup 12 s> W |2 r AR B T Do vt (laagserg £ ikl o)
= Qu GpaniXO [Progran) 3 | ¥okon -
o CH0penOCD_FTONopenccd-0.4 e clopencad exe = o Men
=1 £ Debug-o-port-OpentXD [GOB Mardware Detugang] it o 1000000
= § GOO Hardware Debugger (S125/11 2:54 #M) (Suspended) it s
S o Thread [1] (Suspendad: Sional SIGINT' recerved, Description: Inteengt, ) a2 204003
= 2 k() man. 40 6:00000162 CJE:’ 5
= 1 man{) man.c:71 000000274 Hofl] ok
wi Clysomtolragarto-tockhanibamnone-esbe-odb, exe (572511 2:54 PM) intes 0
i Crimorkspasalio-portiio-port_rom oF (S/25/11 2:54 #M) intre 0
mntey 0
e 0
e 0
nno 0 -
< | »
|
J »
s P = T Ta) (T T o Rl =2 M
& man.c 51N io-port_rommap _[ = BN, Erter location here :l: £ e a
‘2uneigned char count = 03 o 0000015c:  moveq r3, #0 2
17 signed char count_direction = 17 / count direction 000001 5e: movne r3, #1
14 00000160  uxtb rd, rd
Rl ormoagtamyns > WAG AR = et oo 1% 00000162: | Idr &2, (sp, #4)
‘ i6vold wait (int a) 00000164:  edd.w r2, r2, §429496729%
|7 ! 00000168:  str r2, (sp, #4)
{ i while (a-~): l 0000016a: cmp 3, #0
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154 Memory Ea—
Eclupse DA EYEZAE2—[XTIAI FTHRESNATVET,

“Winow” -> "Show View” -> "Memory” Z#IRL T 2 &Ly,

. | window Help

o Mew Window

_ Mew Editor

-

= Open Perspective »

Show v View

d ©c Breakpoints Ale+Shift+Q, B

Customize Perspective.., L= Console Ale+Shife+Q, C
le Save Perspective As... f& Debug
D Reset Perspective... =57 Disassembly

Close Perspective 0 Executables

Close Al Perspectives & Expressions

M

Preferenrac =i Modules

HLOWAEYEZZEMZABICE, EZFNRRLOBBEDTSAKREIVEI )y I LET, UTOETIE

0x2000000 FHD A E) ZE=ZA L TWET,

| o e aer e vait loop =-——=em——essem—- [l® 0oo00162: Ld: :2, (-’, #4)
16void wait (int a) 00000164:  add.w r2, r2, F4294967258
gt 00000168: str r2, (sp, #4)
.‘~, while (a--) 1 _I || 0000016a: cmp r3, #0O
493 0000016c:  bne.n Ox156 <wait+6>
0000016e:  add sp, ¥8
By R N O BT i e Fe ™ AddMemow 00000170:  bx Ir
SantdZ_t main(void) 00000172: nop
{ Wonitor B
FE3_GPIO->ADE = OxOOFF; log Inputs 3 ¢
55 M| AABAAIINL ek fe3 e
« | » «

-3

72 Vosks |5 Protiens| ) o | W Lbys Regrters

20000000 ; 0000000 <Hax> {3 .« New Renderrgs... |

L

> Address [0 - 3 q9 -7 o -» le-r

3 20000000 QOAOSCFF OSO3FFEB 2SDAEEFE
20000010 FOCABCFE Q100FFEF Q0DO77BY ID00SFFA
20000020 CACATDYY QOOOFFEF Z000D7F7 ODDAFEA?
20000030 AGZAEBFF 43005FED 100CF37B OO00ALAL
20000040 SSTSFFEF QO04A0ODFF Z2108FFEB 21DOEFFS
20000050 SOCIICFE Q1007FAF 000077CE ID0049SF
20000060 00ADTDFE 4002FDFB 4000D7F7 ODO6FEED
20000070 E40AFASF  4S006YFS  9SOABE7F  ODOOAAAR

INNNNEN  CENERFESR NANNATTE NENIFITR NENAF TR

& Monitor Memory x|

Enter address or expression to monitor;

| 0x20007000 ~|

@ | OKE I Cancel |

AEYTRFLR RAM® /0 BER) IXBET 25HE. BMOT FLREZTLI Y v LTLIEEL,
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155 JL—IRSA2 rDOER
FRy T EERE. FTRYHRAS VBRI TL—o RS> rERELET,

@ o R O N N B o A=) 0%[!8&-3&-:23\‘”] S iehaa) |
CpenOCD [Frogyam)] | vk -
.B C:AOpenCD_FIDN, 404 Dhpr) o0 5 N Man
= [€] Debugio-pert-OpanOCD [ QD6 Hardware Debupging] BEE m
mmen-n.wcsmnzmmcw i 1792
= P Theead (1] (Suspended) e 1023
[ 00 mn.c:54 000000176 | e 103
ol Ciyagartolysga ) abr-gcb. exe (5[26/11 2:08 PH) e 0
i Criworkspaseljo-portyo-port_rom oF (S/26/11 2:00 PM) e 0
af i
|

[Qbm (@ e 1 S O] Osmsently £ | bt bxatenbere Hom!&"“c'
: 0x3000

45 whide(a--): Al le 00000176 | mav.w &3, #12200
1000001 %a: wove £3, #16387 ; 0x4003
000001 7e: mov.v v2, M2SS ; Oxtt
S 00000162 ate.v t2, (&3, #1280) : OxS00
'S6 PH3_CPIO->DDR1 = OXFFO0: // P18-PiF: LED.
s — = - - : |00000186:  mov.w £3, W12289 : 0x3000
FH3_GPIO->ADE = OxO0FF; // No Analog Inguts 10000018a:  movet £3, §16387 : Ox4003
00000182 ®mov.w r2, NHE5280 ! Oxr100
56 FN3_GPIO->DDR1 = OxFFOO; // P18-PiF; LED-SEG1 outpus ‘00000192:  str.v r2, [r3, #516) 3 0x204
57 FRI_GPIO->DDRY = OxFFO0; // PIS-PIF¥: LED-SEGE cutput 57 FH3_GPIO->DDR3 = OXxFFO0; // F3B-PIF: LED
50 00060196:  mov.v r3, #12200 : 0x3000
56 FH3_GPIO->PFR1 = Ox0000; // P10-PiF: LED-3EG1 GPIO _000001%8:  wmovt rd, F16307 ; Ox4003
S0 FA3_CPIO->PFRI = Ox0000: // P30-P3¥: LED-SECI GPIO - 000001%e: mov.v r2, NES280 : Ox£200 e
63 00000102 : ste.v 2, (&3, #524) : Ox20c
62 FN3_OPIO->DDRS = Ox0000: // P18-PiF: SU2-INTO, S¥3-INTI 59 FRI_CPIO->PFR1 = Ox0000; // P10O-PIF: LED
63 [000001a6:  mov.v £3, N12288 : 0x3000
44 FN3_GPIO->FFRS = Ox0000: // P10-PiF: NW2-INTO, SW3-INTL 000D01aa: move £3, F16387 : 0x4003
s i 0000D1ae:  mov.v r2, #0
- while(l) S 000001b2: str r2, [r3, #4)

F-part-Up s
'rtmnr rate: 37 Eb/zec, 594 hnca/vnu. -
monitor gdb breakpoint override soft
break main
Breakpoint 7 at Ox176: file src/main.c, line S4.
Continue

Breakpoint 1, main {) at src/main.ciS4

54 FN3_GPIO->ADE = OxOQOFF; // No Analog Imputs

>
‘ I'
-
|3 | | l | |

EIDTL—IRA Y bEERET HOICE. EROYV—RA—F2ThLTREFILIV I LET,
55 psasenty 53 [Erverbocaonbece ;”Q@([@"

/ 00000176: | mov.w £3, H12288 -3 0x3000

| 0000037a:  move £3, N16387 : Ox4003

0000017 mov.w £2, 255 ; Oxt2

000001822 atr.v r2, (23, ¥1280) : 0xS00

56 TRI_GPIO->DDR1 = OxFroQ: // Pi1o-Pir: LED
00000186 wov.w ©d, #12288 ; 0x3000
00000106a: movt £3, #16387 ; O0x4003

0000018e: mov.v rZ, #65280 5 Oxf£200
000001921 str.v r2, [r3, #S516) ; Ox204

57 FE3_GPIO->DDR3 = OxFFOO: // F38-P3F: LED,
000001961 mov.v 3, l12208 : 0x3000
000001%a: move £3, §16387 : Ox4003

0000019 mov.v £2, §65280 2 Oxf200 <
00000142 str.w £2, (23, W#S24) 2 0x20¢

59 FR3_CPIO->PFR1 = Ox0000: // P10-P1F: LED
000001063 mov.v ©3, #12288 : 0x3000
00000100: wovt ©d, N16387 ; O0x4003

00000 10e: mov.v r2, ¥0O

000001 str ©2, [c), #4) -
3 I | rl :

-------------- BALD PIOPTANm ~~--=e-—-eceeena
double click here
2 m_caxo’-»n:, = Ox0OFF; // Wo Analog Inputs

56 !’m_ﬁ?l@)bbkl ® OxFroo: // Ple~PiF: LED-3EG1 output
57 FN3_GPIO->DDR3 = OxFFOO: // P38-PIF: LED-SEGZ curput
B

// PIG~PIF: LED-SEG1 GPIO

8
5% FN3_GPIO->PFR1 = Ox0000.
0 /{ P30«PIF: LED-SEGZ GPIO

FH3_GPIO->PFR3 = 0x0000

-

rR3_GPIO->DDRS = Ox0000; // Pif-PiF: 3JWI-INTO, SUI-INTI

~

FR3_GPIO->PFRS = 0x0000; // P10-PI1F; 3WI-INTO, IVI-INTL

FM3_GPIO->PDORY = LEDPATTERN[count / 10]:
B FM3_GPIO->PDOR3 = LEDPATTERN[count - ((count / 10) * v
4l | »

TNV T EBRLES,
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FM3GNU V—ILF = — U & A L -REREEERE

< 0 'ﬁ} =i
Resume {FB Step Into {F5}| /‘\hnsh'uchnn Stepping Mode |

Step Over {Fﬁ}

|Tv.=_-rm|r|ate (Cirl+F2) ]

|Step F‘.Emrn {F?}I|

TJL—9RA v MZE

vbhFHE UTORDESIZHEYET,

= < 7
= 0= cesssently 1 [Ereociocatabere Hl e »le TS0
= 000001d2: mov.v r3, N12ze8 7 Ox3000 -l
~~~~~~~~~~~~ PALL PEOQEA ===wwwww 000001d6: movt r3, H16387 ; Ox4003
mr.32 _t main(void) 00000da: mov.v r2, KO
ol 000001de: str r2, (r3, ¥20)
4 FN3_CPIO->ADE = OxO0FF: // No Asalog laputs 00000te0: D.n Oxle8 <mainellé>
S5 ; nt / 10
56 FM3_GPIO->DDRI ~ OxFFOO: / P18-p1¥: % 000001e8: 3, #2288 2 0x3000
7 FM3_GPIO->DDRI = OxFFOO; / PIB-pIY: 0CC30s 336387 ONADOS
-8 00000120 movw £2, #3I2776 : Ox3008
5 FH3_GPIO->PFR1 = Ox0000: / P10O-P1F: 00000824 move ¥2, #8191 ; Oxirre
4 IN3_GPIO->PFRI = Ox0000; PIO-P3¥: LE 00000128 ldrd r1, (£2, ¥O)
! 000001242 movw 2, NS2429 : Oxcced
rH3_GPLIO->DDRS = 0Ox0000; / P18-P1F: SV2-INTO, S¥I-INTL 000001 Ze: move £2, #S2428 : Oxeccee
K 00000202« woull 20, ¥2, £2, £l
44 FHI_GPIO->PFRS = Ox0000: // P10-P1F: SWI-INTO, SWI-INT1 00000206 mov.v €2, €2, lsc N3
22 000002Qa: uxeh r2, 2
6 while(l) 0000020¢: =ov £1, 2
¢ 0000020e: move 12, #1732 : Oxécd
FE} _GPIO->PROR1 = LEDPATTERN(count / 10); 00000212 : move 12, WO
FN3_GPIO->PDOR3 = LEDPATTERN([count - ((count / 10) * 1t 00000216: ldch.v £2, [r2, ©l1, 1=1 #1)
0000021a; str.vw T2, [, #1028} 7 0x404 o
walt (10000002 / wait scoe Cine P -, AREA L ARARS o 4 AR - e '
» < | »
» = ~ = o Py
BX x| es 8 -r5-°0

force soft brenkpolnta
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FM3GNU Y—IFr—2%#ERALI-FRREEBERZE

16 {8

16.1 FEE
AKETHRAT HBEBEBEZTRICELEDHFET,
BE:E B BREA

*.bin Binary Format File TGS LT—HDOH#BNEFEFNTNEIT+—T Y b

(PR3RF)

* elf Executable and Linkable Format TNYTER(DVRIL, T RLR, EDa—ILEE) EZEATE

(HE3RF) TA—I vt

*.hex Hexadecimal format file (Intel) TOYSLT—RET FLRABREEARZ 7+—< v

(PEERF) (Intel 74—< v k)

*.mhx Motorola Hexadecimal Format File TATSLT—2ET7 FLRBREEAEIA—T Y

(PR3RF) (Motorola S-Records 7+ —< v k)

CDT C/C++ Development Tooling Eclipse D3> 745 L—Y 3 v THERASADY—ILF—2

EABI Embedded-Application Binary Interface Linux MITD., $HAHY T bz 7HEITA V2 T —ADRE
T+—T vk

FTDI Euture Technology Devices International Ltd. #4, 3 LLIFITAG £ USBDETF Y T EZEKT S

JTAG Joint Test Action Group N—F9z7 (RETIEMCU) DTR L, TR T THERAT S
FETHY. IEEEL149.1 L LTESHBNTIND

JRE Java Runtime Environment PCLEtTJava7 Ly b (B XX Eclipse) #8E s €518
DBy

GDB GNU Debugger GNUY—ILFI—2DF/INyH

GNU “GNU’s not Unix” GNUY—IFz—r,  LL@EFA =TV T +rHzT7EHH
570019 h4

LibUSB Library for USB F—FIV—RS5L4TSUDUSB KSA/1ThHY. AETIE
Windows B IFIZa /8 JLLE=3DEFERL TS

None-EABI None-Embedded-Application Binary Interface Linux @I+ THL, #AHFY I bz 7RERITAVETI—AD
BREIA—I v b

oCcD On-Chip Debugger/Debugging FoFvITNYITRATOTINY A, KETKITAG 70 +
JLEER

OpenOCD Open Source On-Chip Debugger F—FoV—RaA—FOFNYH

YAGARTO “Yet another GNU ARM tool chain” Windows M IFIZ#tEE a > /8f ILEN = GNU Y —ILF = —
>
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FM3GNU Y—IFr—2%#ERALI-FRREEBERZE

16.2

16.2.1

16.2.2

17

>y

Yy2bkozx7

Eclipse IDE:
http://download.eclipse.org/eclipse/downloads/

Yagarto Tool Chain:
www.yagarto.de

OpenOCD:
http://openocd.sourceforge.net/

LibUSB:
http://sourceforge.net/projects/libusb-win32/files/

Embedded System Register View Plug-In for Eclipse:
http://sourceforge.net/projects/embsysregview/

JRE:
http://java.com/

N—Fozxz7F
IAR $#t & J-Link

http://www.iar.com/Global/Products/Hardware-Debug-probes/DS-J-Link-ARM-09.pdf

olimex #t® ARM-USB-TINY

https://www.olimex.com/Products/ARM/JTAG/ARM-USB-TINY/

HA4 TLAHE SK-FM3-176PMC-ETHERNET V1.1

http://www.cypress.com/SK-FM3-176PMC-ETHERNET

MURL [FFPERLCEBSNLARMENHY FT,

EBNTEER

YA TLRICEAT HBERIE TNV IR—IHSBSRBTEET,
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ARM® Cortex® Microcontrollers cypress.com/arm PSoC 1| PSoC 3 | PSoC 4 | PSoC 5LP
HHA cypress.com/automotive YA FLABEREIS =T«
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